BBCC Website Guide for Page Editor

This document details the different structures that are used in pages and why they are used,
proper media file management on the website, procedures to maintain standard accessibility,
and a guide to the custom elements. While it is recommended that you read the entire
document, a good starting point is the Standard steps to build a page.
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Page Structure
General Structure

The pages on the website follow a general structure of header, body, and footer.
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Art is a human expression. In the art department, the studio method of learning emphasizes the development of individual creativity and
technical competence. The department’s objective is the achievement of a sense of involvement, integrity, and creativity by the student.

The department provides basic disciplines in the arts for art majors, other students, and citizens of the community. In developing each
individual's talent and interests, equal emphasis is on mastery and the appreciation of all art forms. The curriculum probes aspects of visual
communication, which focus the eye, mind, and hand in the technical and creative awareness the student needs to adequately prepare for
his/her major area of study and for transfer to four-year college or university.
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e The page header contains the page title and title background image if there is one.
e The page body contains the primary content (text, links, images, etc.) of the page.
e The page footer contains contact, faculty/staff members, or additional links of the

page.
These should not be confused with the site header, site body, and site footer.
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Art is a human expression. In the art department, the studio method of learning emphasizes the development of individual creativity and
technical competence. The department’s objective is the achievement of a sense of involvement, integrity, and creativity by the student.

The department provides basic disciplines in the arts for art majors, other students, and citizens of the community. In developing each
individual's talent and interests, equal emphasis is on mastery and the appreciation of all art forms. The curriculum probes aspects of visual
communication, which focus the eye, mind, and hand in the technical and creative awareness the student needs to adequately prepare for
his/her major area of study and for transfer to four-year college or university.

A variety of art courses are offered for the student and the community. The art student may select from such fields as art history, two and
three-dimensional design, drawing, painting or ceramic art.
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The site header contains the menu navigation, important links, the search bar, and
the Big Bend logo.

The site body contains all of the content of a page, this includes the page header, the
page body, and the page footer (the ‘page’ terms in this convention aren’t used
broadly, they are used in this manner here for page editors as they cannot edit the
site header or site footer).

The site footer contains a list of sitewide links (including legal links), the copyright
information, and the Big Bend general contact information.




The site header nor the site footer can be edited with the standard editing permissions. The
only section that can be edited is the site body.

The sections below detail the types of structures that are available and recommended when
creating pages.

Program Page/Department Page

What and Why?

The program/department pages are used for primary pages (eg. Art, Veteran Services, etc).
The structure is fairly similar with both of these with the only main difference being that the
department structure not including buttons at the top by default. The structure follows as
such:

Page Header
Page Title and background image
Page Body
Primary Buttons (or a replacement important item. For example Veteran Resources has a
Notification element and Stem Center has hours of operation)
Main content
Page Footer
Contact Information Faculty/Staff members Additional Links

The structure for primary pages such as these should be followed to maintain design
consistency. The optional changes include:

e Not having primary buttons or another important item.

e Not having Faculty/Staff members section. Be sure to swap the footer templates to
match the Page footer sections needed (simply deleting the column will not work
properly).

Not having Additional Links section. Be sure to swap the footer templates to match the Page
footer sections needed (simply deleting the column will not work properly).

How?

Follow the steps to create a new page (see Standard steps to build a page) and use the
Program Page or Department Page template. Adjust the template as need be.

Basic Page

What and Why?

The basic page is used for secondary pages (eg. Art Program Options, Student Clubs and
Communities, etc). The structure follows as such:

Page Header
‘ Page Title and background image
Page Body



https://www.bigbend.edu/academics/art/
https://www.bigbend.edu/student-center/veteran-services/
https://www.bigbend.edu/student-center/veteran-services/
https://www.bigbend.edu/academics/stem-center/
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https://www.bigbend.edu/student-center/student-clubs-and-communities/

Main content Secondary content/return to
primary page

Page Footer (optional)
| Contact Information | Faculty/Staff members | Additional Links |

The structure for secondary pages should be followed to maintain design consistency. The
optional changes include:
e Replacing Return To Page element with the Contact element
e Add a Contact Block, Contact/Staff Block, Contact/Links Block, or Contact/Staff/Links
Block element.

Follow the steps to create a new page (see Standard steps to build a page) and use the Basic
Page template. Adjust the template as need be.

Custom Pages

What and Why?

There are a collection of pages that do not follow the standard structures shown above (for
example: homepage and Parent page). These pages were built by people knowledgeable in
building pages that fulfil their purpose, being accessible, and maintaining design consistency
with the rest of the website. It is highly recommended that you follow one of the above
structures despite whether you consider yourself technically capable.

How?

Building custom page structures should only be done by users who are proficient in web
design, can maintain page accessibility, implement good design practices, and maintain
design consistency. Your custom page must also be approved by Matt Killebrew and/or the
Big Bend web developer (if there is one).

Media

How to upload media
How?
1. Navigate to the Media tab.

(@ WP Activity Log

A Posts
O3 Media

Library



https://www.bigbend.edu/
https://www.bigbend.edu/i-am/parent/

2. Click Add New or click Add New from the menu.

— i Media Library

- Goodlayers

(@ we Activity Log E All media items v All dates
f Posts

O Media

— —

Library

) _ Fall-2021- =
Add New

Reaistration- Important-Dates-Fall-

3. Select the file to upload.
4. (images only) Smush the file if it gives you the option to. This is for optimization.

5. Insert images from within the page editor or copy the link from the Media Library for
non-image media to link to it.

P

File URL https://dev.bigbend.edu/wp-content/uploads/waitlisAllStres:

| Copy URL to clipboard |

*Be sure to follow the Media Accessibility documentation.

File Recommendations (name, size, types)

e When naming your files, it’'s recommended that you name your file something
descriptive, but not long. A bad example would be
pictureOfJobFairTableWithStudents.png. A good example would be something like
Pizza-day-2021.jpg.

If you want to have the image easily findable and reusable, it'd be a good idea to put
in a word you can search later. For example, you’re uploading images for a club or
program, you can include the club or program name/acronym.

e Equally, make sure the file isn’t too short or vague. A bad example would be
something like catalog.pdf. The reason why is because file URLs are limited, using a




top level one like that would lock that URL away from more important/official
documents using it. This was an issue on the old website with users naming files
something simple and not allowing official documents (which would then need to be
named something like catalog2.pdf).

e When naming a file, there are times when to include a date (full or partial) or to leave
it off. If you are uploading an image or poster for an event, that would be a good use
case to include the date in the filename. A good example would be
jobFairPoster2019.pdf.

If you are uploading a file that will be updated and used over time or if you will
frequently replace the file with revisions, it’d be best to leave the date off. For
example, the advising maps would be best to not include the date since those would
be replaced over time and we’d rather not have to change the links every time we
have a new version.

If you need to keep previous versions of files (eg. different years of the class
schedules), that is also a good use case for having a date in the filename. A good
example would be Winter-2019-Planning-Schedule.pdf.

When it comes to file sizes, the rule is that smaller is better on the web. Why? It all has to do
with speed. A larger file takes longer to load, especially when on a mobile connection. It’s
easy to forget how long it takes to download an additional file or for a webpage with a bunch
of images to load when you have decent internet, but this is especially an issue for those who
have limited mobile data connection or free internet from locations like the library at peak
times or from some café.
Lower income population are especially going to be most frustrated with slow load times.
The max-recommended size for an uploaded file would be 1MB, though you should make it
smaller if you can.
Here is a list of some easy file compression tools to optimize file for upload.

e For images: https://imagecompressor.com/

e For PDFs (select High compression):

https://www.adobe.com/acrobat/online/compress-pdf.html

e Word documents: https://www.wecompress.com/en/

File Types

These are the recommended file types for uploading to the website:

e Images: png, jpg, jpeg, gif, webp

e Documents: doc, docx, txt, pptx, xIsx, and PDF. PDF is the recommended file format
for the web as it can be opened by nearly any device with a browser. The other
formats require additional software to view/edit.

e Videos: it is highly recommended that you host videos on a video hosting platform
(eg. Youtube, Panopto, Vimeo, etc.) as it’ll perform better. If you are required to
upload a video to the website, the recommended format is mp4 and webp.

*webp is a new type of file format for images and videos. It is more optimized than
conventional formats, which is why it is recommended, though not all older browsers
support it.



https://imagecompressor.com/
https://www.adobe.com/acrobat/online/compress-pdf.html
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Replacing Media

How to replace media?

1. Go to the Media Library and select the file to replace.

R Media Library

- Goodlayers

S

WP Activity Log E All media items | ‘ All dates

A Posts

O3 Media

Library = —
Fall-2021- el

1]

Add Mo Importan
Add New

Registration- Important-Dates-Fall- Summer-t
Add From Server Information.pdf Quarter-2021.pdf 2021.

B Pages
2. Click “Upload a new file”.

l Copy URL to clipboard l

Required fields are marked *

Replace mediza l Upload a new file ]
]
To replace the current file, click the link and upload a replacement.

Slide link |

Shortcodes Ultimate

len thir fnld +0 add cuctoms linlee 40 clidac oend anth Cliclare

3. Select the new file (must be the same file type).
4. Set the Replacement Options to “Just replace the file” and Date Options to “Replace
the date”.

Replacement Options Date Options
® Just replace the file When replacing the meda, do you want to:
Note: This option requires you to upload a file of the same type (jpg) as the one you are replacing. The name of @ Replace the date

the attachment wil stay the same (virtual-Vikings-2021jpg) no matter what the file you upload is called. () Keep the date (oaaria0z1 1123)
) Replace the file, use new file name and update all links '@ SEOEEENELS

Note: I you check this option, the name and type of the fi about to upload will replace the old file. Al

links pointing to the current file (Virtual-\ d to point to the new file name. (If any

other websites link to the file directly, those links will no longer work. Be careful)

Cancel

5. Click Upload. If the old file still show on the dev.bigbend.edu page/pdf, try refreshing
your tab a few times.
Note: follow Media Accessibility and File Recommendations documentation.




When to upload a new file vs replacing the file

If you need to keep a previous version of a file or are it’s a new file altogether: upload a new
file.

If you would like to update an existing file and don’t need to keep the previous version of the
file: replace the file using.

Title Background Images

The Title Background Image is the background image for a page title as the page header.
It can be set to different sizes. Though the dropdown shows five different options, the two
recommended sizes are Default and Medium.
e Defaultis the larger of the two options. This is to be used for primarily for the main
program pages (Art, History, etc.), but it can be used for some other main landing



https://www.bigbend.edu/academics/art/
https://www.bigbend.edu/academics/history/

pages. Here is an example:
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Artis a human expression. In the art department, the studio method of learning emphasizes the development of individual creativity and
technical competence. The department's objective is the achievement of a sense of involvement, integrity, and creativity by the student.

The department provides basic disciplines in the arts for art majors, other students, and citizens of the community. In developing each
individual's talent and interests, equal emphasis is on mastery and the appreciation of all art forms. The curriculum probes aspects of visual
communication, which focus the eye, mind, and hand in the technical and creative awareness the student needs to adequately prepare for
his{her major area of study and for transfer to four-year college or university.

A variety of art courses are offered for the student and the community. The art student may select from such fields as art history, two and
three-dimensional design, drawing, painting or ceramiic art.

Art Contact ArtFaculty/staff Additional Links
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e Medium is the smaller of the two options. This is to be used for primarily for the
secondary pages (Art Program Options, Student Clubs and Communities, etc.). Here is
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an example:

Covid-19 Information
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' " Art Program

since programs differ at each college, students should consult program outlines € Backto mainpage
published by the college or university to which they intend to transfer. The following
recommended courses prepare students for most baccalaureate institutions.

Students should prepare their quarterly schedules with the assistance of an advisor

knowledgeable in this transfer area.

+ Recommended Pre-Major Courses

+ Recommended Art Electives
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To set the Title Background Image:
1. Go to the page editor for the page you’d like to edit.
2. Scroll all the way down to Page Options->Layout

Header Bullet Anchor

[11]

Layout it

L

Select Custom Header




3. Go to Page Title Background and select an image from the Media Library (follow the
How To Upload Media documentation for new images).

Page Title Background

Enable Breadcrumbs

4. Save your changes.

To set the Title Background Image Size:
1. Go to the page editor for the page you’d like to edit.
2. Scroll all the way down to Page Options->Title Style

Layout Title Style Header Bullet Anchor

Page Title Style

Default

Page Title Style

Default v

4. Save your changes.

Image recommendations:
e Make sure your image is horizontal orientation (wider than it is tall).




e Make sure it isn’t too white. It needs to provide enough contrast with the white title
text.

e Don’t use images that have text or logos.

e Don’t use images with too much clutter or details. This is a background image, don’t
try to use it to showcase particular objects. Especially since at different screen sizes
(i.e. mobile, tablet, laptop, etc.) the image will crop differently.

e Choose an image with high enough resolution. If you choose an image that’s too low
in resolution, it’ll stretch the image and blur it. The minimum recommended
resolution is width 1900 and height 400 (1920x1080 is fine, you don’t have to crop
your image to the minimum recommended).

e Choose images that show a general concept. Choosing something that’s too specific
won’t work as background image and will both not show the specific item well in all
screen sizes and will distract from the page title.

Accessibility
Text Formatting

Colors

The option to edit text color within the text editor has been removed because use of it
previously introduced accessibility issues and design inconsistency. To maintain enough
contrast to be accessible and to keep the design consistent, do not force different text color
within page content.

There are a few places where the text color is something other than black, but those are
setup within the templates to have AA or AAA contrast as well as being consistent with other
templates.

Be aware that copying content from external sources can override text color. Be sure to copy
content correctly as shown below under “Copying Formatting from other sources”.

Bolding, italicizing, and underlining

Using the text editor, you can bold, italicize, and underline text. When doing so, try to only do
one at a time for the same text since it can get messy doing multiple at the same time.

File v Editw View » Inserfy Format» Tools w Table w

B I U = ~v = v = = = GDLR Core v M
= =i = — wy [

<= 2 W ¢ % v PE & & 1Al

Descrintion of what this nrogram is and the exnected outcomes. Taorem insum d
Be aware that when copying content from an external source, it can carry a version of each of

these formatting that is less accessible.
e Bolding: there are two different types of tags used bolding formatting that is on the
web. There is <b> and <strong>. They look the same, but <strong> is the accessibly




option since it provides semantic emphasis while the <b> tag is purely for decorative
purposes. If using the text editor within the page builder, it will use <strong>.

e |talicizing: there are two different types of tags used italic formatting that is on the
web. There is <i>and <em>. They look the same, but <em> is the accessibly option
since it provides semantic emphasis while the <i> tag is purely for decorative
purposes. If using the text editor within the page builder, it will use <em>.

e Underlining: Generally underlining is the less recommended form of formatting
(bolding and italicizing are better) for emphasis. There are two different ways to do
underline formatting on the web. There is <u> and using CSS styling, While they will
look the same, the CSS styling is the recommended since underlining is considered
non-semantic and purely decorative. If using the text editor within the page builder, it
will use CSS styling.

Be sure to copy content correctly as shown below under “Copying Formatting from other
sources”.

The option to edit font size within the text editor has been removed because use of it
previously introduced design inconsistency. To keep the design consistent, do not force
different font sizes within page content.

There are a few places where the font size is something other than 18px, but those are setup
within the templates to be design consistent with other templates.

Be aware that copying content from external sources can override font size. Be sure to copy
content correctly as shown below under “Copying Formatting from other sources”.
Heading Formatting

The option to edit heading formatting within the text editor has been removed because use
of it previously introduced accessibility issues and design inconsistency. To maintain heading
order to be accessible and to keep the design consistent, do not force heading formatting
within page content.

Be aware that copying content from external sources can override heading formatting. Be
sure to copy content correctly as shown below under “Copying Formatting from other
sources”.

Table Resizing

The option to edit table columns/row sizes within the text editor has been removed because
use of it previously introduced issues for mobile users. Previously whenever a user would
resize a column/row, it would set an exact pixel size. They would usually get scaled for
desktop/laptop and look fine there, but once switched to mobile, the table would go off the
edge of the screen. Do not attempt to force table column/row resizing as they will
automatically resize to fit the contents within (as long as your table doesn’t have too many
columns). If your table has a lot of columns, consider consolidating it to hold only the most
crucial information. If that is not an option, wrap your table with this shortcode (bolded) as
such:

[su_table responsive="yes"]

W column




row | |
[/su_table]
This will make your table scrollable on mobile if it goes off the edge of the screen.

Be aware that copying content from external sources can override text color. Be sure to copy

content correctly as shown below under “Copying Formatting from other sources”.

Copying Formatting from other sources.

When copying content from external sources (another webpage or a document), frequently it
will carry unwanted and inaccessible formatting with it.
There are two methods for copying content from other sources.

1. Paste without formatting (recommended, but not for tables): after you’ve copied the

content, you can right click and select “Paste as plain text” or click Ctrl+Shift+V.
AT T11S PrOgje o s o

lesent ac lo il

Curabitur

Paste
Paste as plain text Ctrl+5h

Select all

Spell check

Witing Direction
Inspect

Additionally you can toggle the “Paste as text” option and that will remove formatting
from pasted content.

File v Edite WView Inseh« Formate Tools »

2. Clear formatting after pasting (recommended for tables): after you’ve copied and
pasted your table, select the entire table and click the “Clear formatting button”

(eraser).
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This is recommended only for table and not for other formatting as sometimes it
doesn’t clear all of the formatting from the copied content (due to copied structure).

Once you've copied over your content from the external source, you can reapply formatting
provided with the text editor options within the page builder.

File y Edity Viewy Inserty Formaty Tools y Table v
B I U v v = = =9 GDLF
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Media Accessibility

Alt Text for images

For every image uploaded, you need to set an alt text.
The alt text is an accessibility feature that shows the contents of the alt text for screen
readers. The screen reader is an accessibility technology that audibly reads page content for
those with visual impairment.
To set the alt text, follow these steps:

1. Go to the Media Library and select the image you’d like to add the alt text to (if
uploading an image, skip this step)
B Media Library | Addnew |

! Goodlayers

@ WP Activity Log | Al mediaitems v | | All dates v | | Smush: Allimages v | Bulk select ‘

A Posts

ep E B B B

Important-Dates- Summer-2021-
Registration- Important-Dates-Fall- Summer-Quarter- Registration-
Add From Server Information.pdf Quarter-2021.pdf 2021.pdf Information.pdf

Add New
Student
2021

E

B Pages

¥ Comments
A Personnel

% M.E. Calendar S0C-320- PHIL-340-April- MGMT-370- MGMT-305- CMST-
b May2021.pdf SIM-161-Oct2015.pdf 2021.pdf Apr2021.pdf May2021.pdf GIS-210-Mar2017.pdf DVS-070-4-2021.pdf b




2. Enter a value into the Alternative Text. This needs to be descriptive and yet brief (up
to 1 sentence, some sources recommend up to 125 characters). If your image has text
(avoid images with text if possible), enter the text into the alt text. If it's a person,
location, or event, enter that. Usually a good method for other scenarios is taking
what you see in the first few seconds in the image and writing that.

Uploaded on: Ma

Uploaded by

Title ‘ Elizabeth Valle

| https://dev.bigbend.edu/wp-content/uploads/E

3. (optional, but recommended) Enter the title text. The title text has a similar function
to the alt text, except it shows when you hover over the image. Frequently enough,
you can use the same text in both, but it can be different. For example, a product
page could have images with alt texts that describe the images while the title texts
could also include details like color or pricing. The use varies.

File size: 371 KB

Dimensions: 1

by 2048 pixels

Original image: Elizabeth-Valle,jpg

Alternative Text | Elizabeth Valle

scribe the purpose of the image. Leave empty if the image is purely

Making media accessible
e PDFs: http://cats.cuny.edu/media-accessibility-project/pdf-accessibility/
e Word documents: http://cats.cuny.edu/media-accessibility-project/microsoft-word-

accessibility/

e PowerPoint: http://cats.cuny.edu/media-accessibility-project/microsoft-powerpoint-

accessibility/

e Additional Resources: https://www.bigbend.edu/about-us/accessibility-cheat-sheets/
Making external video/audio accessible.



http://cats.cuny.edu/media-accessibility-project/pdf-accessibility/
http://cats.cuny.edu/media-accessibility-project/microsoft-word-accessibility/
http://cats.cuny.edu/media-accessibility-project/microsoft-word-accessibility/
http://cats.cuny.edu/media-accessibility-project/microsoft-powerpoint-accessibility/
http://cats.cuny.edu/media-accessibility-project/microsoft-powerpoint-accessibility/
https://www.bigbend.edu/about-us/accessibility-cheat-sheets/

When linking to an external video or audio source, it's recommended that you caption or
include the transcript for that media.
e Youtube: https://support.google.com/youtube/answer/2734796?hl=en#zippy=
e Vimeo: https://vimeo.zendesk.com/hc/en-us/articles/224968828-Captions-and-
subtitles
e General captioning tips: https://www.bigbend.edu/about-us/accessibility-cheat-

sheets/

Custom Template Guide
Why use Custom Templates?

The Custom Templates are made to be design consistent, accessible, mobile friendly, and
visually pleasing. Using these will ensure that the pages will look good on desktop and mobile
while ensuring that our content is accessible to our users. While you can technically write
custom code or use external formatting, you should not do so as that will make the pages look
poor, inconsistent, and can decrease accessibility. Using the standard Elements is also possible,
but it’s also not recommended due to the above reasons. To ensure that the site is the best it
can be, follow the guide below on what the Custom Templates are and how to use them.

Example Template List: https://www.bigbend.edu/about-us/custom-element-list/

Note: Page templates are made up of multiple blocks to provide most/all of the pieces needed
for a page. Block templates are made up of multiple elements to fulfill a purpose, these are
generally full width (depending what the width is set to for the block). Element templates are
the individual pieces used to fulfill some purpose, their widths can vary.

Department Page

What and Why?

Example Title Text

Description of what this department is and the services it offers. Lorem ipsum dolor sit amet, ~
consectetur adipiscing elit. Praesent ac lorem sed augue imperdiet posuere non non elit. Mon-Thurs 07:30-4:300

Donec tempus sapien in erat efficitur maximus. Curabitur ultricies a nibh convallis sodales.
P P Friday 07:30-3:300

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla, consequat
ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce dapibus, urna ac
dictum efficitur, dui turpis molestie libero, at ultrices erat purus non erat. Praesent eu tristique
arcu, vel facilisis mi

sat-Sun Closed®

Program/Department Program/Department Faculty/Staff Additional Links
Contact
& Link
= primary@email.com No personnel found, please create the personnel post to use the item
B Link

o (509) 509-5095

B Building 1800

¥ Room 1800



https://support.google.com/youtube/answer/2734796?hl=en#zippy
https://vimeo.zendesk.com/hc/en-us/articles/224968828-Captions-and-subtitles
https://vimeo.zendesk.com/hc/en-us/articles/224968828-Captions-and-subtitles
https://www.bigbend.edu/about-us/accessibility-cheat-sheets/
https://www.bigbend.edu/about-us/accessibility-cheat-sheets/
https://www.bigbend.edu/about-us/custom-element-list/

Description: The Department Page provides a collection of blocks that will likely be useful in
making a department page (though it can be modified for other pages as well). Different
blocks can be swapped out to fit different needs. See the Swappable Blocks list below.
Resizable: No.
Swappable Blocks:
e Body: You can swap the body with these compatible blocks; Default Block,
Content/Hours Block, and Basic Page.
e Footer: You can swap the footer with these compatible blocks; Contact/Staff/Links
Block, Contact/Staff Block, Contact Links Block, Contact Block, and Links Block.
e Other: you can add a Buttons Block at the top.
Additional Notes:

How?

1. Search within the Custom Templates “Department Page” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements @) Custom Templates () syncTemplates

iFrame Element Alert Box Element Back To Page Element Contact Element Tabs Element

‘White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block

Program Page Department Page
2. Dragthe template from the Custom Templates list and then drop it into a compatible
template.

Department Page

el Example Title Text

Description of what this department is and the services it offers. Lorem ipsum dolor sit amet,
consectetur adipiscing elit. Praesent ac lorem sed augue imperdiet posuere non non elit. Donec Mon-Thurs
tempus sapien in erat efficitur maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla, consequat ut

Sat-Sun

ante sed, sagjittis venenatis sem. Aenean non neque sapien. Fusce dapibus, urna ac dictum
efficitur, dui turpis molestie libero, at ultrices erat purus non erat. Praesent eu tristique arcu, vel
facilisis mi.




3. To edit the body of the page, see Content/Hours Block. You can also replace it with
one of the Swappable Blocks listed above.

4. To edit the footer of the page, see Contact/Staff/Links Block. You can also replace it
with one of the Swappable Blocks listed above.

5. Click Save Options and then click Save Draft.

6. If you are finished making changes, you can click Publish and then Submit For Review.

Program Page

What and Why?



B Apply Now 8 courses M Advising Maps = ContactUs

Example Title Text

Description of what this program is and the expected outcomes. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem
sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla, consequat ut ante sed, sagittis venenatis sem. Aenean non
neque sapien. Fusce dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non erat. Praesent eu tristique arcu, vel

facilisis mi.

]

\ l ,\ ‘y " ulﬁ : 1l Program Outcomes Career Possibilities Transfer Options. Industry ps & Grants
! I ]
W I ! i
. 17 ‘

1 o 1" 1 1. Lorem ipsum dolor sit amet
2. consectetur odlpxscmg elit

|
) i ’ 3. Praesent ac lorem sed augue

T
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See What It's All About

See mof@Vvideos

Degrees & Certificates

DEGREE NAME
CERTIFICATE NAME

Program News

Example Article Name

See more articles

Program/Department Program/Department Faculty/staff Additional Links

Contact

\ A A & Llink
= Primary@emailcom ) ) )
g e ) B Link
o (509) 509-5095 / / /

TLATENCHI, DELIA STANDLEY, DEPREE RAMIREZ, CHRISTIAN

B Building 1800
ESL Instructor Business & Accounting Faculty Associate Faculty Crop Science

@ DelioT@bigbend.edu @ Deprees@bigbendedy @ ChristianRo@bigbend edu

¥ Room 1800

Description: The Program Page provides a collection of blocks that will likely be useful in
making a program page (though it can be modified for other pages as well). Different blocks
can be swapped out to fit different needs. See the Swappable Blocks list below.
Resizable: No.
Swappable Blocks:
e Body: You can swap the body with these compatible blocks; Default Block,
Content/Hours Block, and Basic Page.




e Program Content: Below the main Body, there are the following blocks in order;
Program Info Block, Video Lightbox Block, Degrees & Certs Block, and Program News
Block.

e Footer: You can swap the footer with these compatible blocks; Contact/Staff/Links
Block, Contact/Staff Block, Contact Links Block, Contact Block, and Links Block.

e Other: you can remove the Video Lightbox Block and Program News Block there isn’t
a need for them.
Additional Notes:

How?

1. Search within the Custom Templates “Program Page” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ) Custom Templates () syncTemplates

iFrame Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Element Featured Element Featured Block Personnel Card Page Personnel Bio Page

Video Lightbox Block

Content/Hours Block Links Block




3.

2

Drag the template from the Custom Templates list and then drop it into an empty
page.

Program Page devTemplatePrograminfo

B Apply Now

To edit the buttons, see the Buttons Block.

Wrapper =z & & & X

To edit the body of the page, see Default Block. You can also replace it with one of the
Swappable Blocks listed above.

To edit the program information, see Program Info Block.

To edit the video section, see Video Lightbox Block.

To edit the degree and certification information, see Degrees & Certs Block.




8. To edit the program news, see Program News Block.

9. To edit the footer of the page, see Contact/Staff/Links Block. You can also replace it
with one of the Swappable Blocks listed above.

10. Click Save Options and then click Save Draft.

11. If you are finished making changes, you can click Publish and then Submit For Review.

Contact/Staff Block
What and Why?

Program/Department Contact Program/Department Faculty/staff

& Primary@email.com No personnel found, please create the personnel post to use the item
¢ (509)509-5095
B Building 1800

F Room 1800

Description: The Contact/Staff/Links Block provides contact information and faculty/staff for
the department/program.

Resizable: No.

Compatible Pages: Department Page, Program Page, Basic Page

Additional Notes: This is a full screen width template. This is meant to be the only page
footer template. If you’d like add/remove a section, consider using the Contact/Staff/Links
Block, Contact/Links Block, Contact Block, or Links Block.

How?




1. Search within the Custom Templates “Contact/Staff Block” (case insensitive and
partial keywords allowed)

Wrapper / Columns & Elements 4 Custom Templates () Sync Templates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Diader Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttors Block Content/Hours Block Links Block

Example Title Text [su_icon icon="icon: arrow-1¢]

Example Text. Loreg
sed augue impg
maximus.

psum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem
iet posuere non non elit. Donec tempus sapien in erat efficitur
abitur ultricies a nibh convallis sodales.

Back to mainpage

r lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla,

equat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce
dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non
erat. Praesent eu tristique arcu, vel facilisis mi.

Program/Department Contact Program/Department Faculty/Staff

3. To edit the contact information, see Contact Block.




4. To edit the faculty/staff information, click the pencil icon to edit the template (orange
outline with the Personnel title)

= XX

am/Department
Contact

icon icon="icon:
envelope-o"
round="transparen
="white" size="16"

gin="0Opx Opx Opx

ta5 Z I & x

Progrum/Department Facult

Personnel [ X [lX
e | found, please create the personr

5. Once there, you can edit the categories it shows. Select one in the shown box or
select multiple while holding the CTRL button.

General Style

Category

Adminisiration
Advising Maps
Advisor

e —]
Art

Associated Student Body
Automotive Technology

Num Fetch

3

Typography Shadow Spacing tem Title

ou can use Cirl/Command button o select multiple items or remove the

selecled ilem. Leave this field blank fo select all items in the list

The number of posts showing on the personnel item

To edit the personnel that show in the category or to add a new category (when
adding a new department/program), contact Matt Killebrew. Please note that
categories should not be added frivolously (for example, for a temporary event or

club).

6. Other settings: if your page isn’t showing all of your personnel, increase the Num

Fetch amount.




Num Fetch

If you’d like to organize your personnel differently, you can change Order By and
Order.

Order By

Publizh Date w
Order

Descending Order w

If your category has fewer than 3 personnel, you can change the Column Size under
the Style tab. If you have 1 personnel, set it to 1. If you have 2 personnel, set it to 2. If




you have 3 or more personnel, set it to 3 (do not set it higher).

Genera Style Typography Shadow Spacing tem Title

Text Align

Personnel Style

Thumbnail Size

7. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m

8. If you are finished making changes, you can click Publish and then Submit For Review.

Contact/Staff/Links Block

What and Why?



Program/Department Contact Program/Department Faculty/staft Additional Links

& Primary@email.com No personnel found, please create the personnel post to use the item % Link

« (509) 509-5095 Link

H Building 1800

¥ Room 1800

Description: The Contact/Staff/Links Block provides contact information, faculty/staff for the

department/program, and additional links.

Resizable: No.

Compatible Pages: Department Page, Program Page, Basic Page

Additional Notes: This is a full screen width template. This is meant to be the only page

footer template. If you’d like add/remove a section, consider using the Contact/Staff/Links

Block, Contact/Links Block, Contact Block, or Links Block.

1. Search within the Custom Templates “Contact/Staff/Links Block” (case insensitive and
partial keywords allowed)

Wrapper / Columns & Elements £ Custom Templates () Sync Templates

iFrame Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Dinader Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Example TitlgfText [su_icon icon="icon: arow-left"
background="transparent”
color="white" size="16" margin="0px
0Opx Opx Opx” target="self | [/su_icon]
Back to mainpage

Cuyflibitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla,

Dnsequat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce
dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non
erat. Praesent eu tristique arcu, vel facilisis mi.

Program/Department Faculty/statf

3. To edit the contact information, see Contact Block.

4. To edit the additional links, see Links Block.

5. To edit the faculty/staff information, click the pencil icon to edit the template (orange
outline with the Personnel title)

F b Zx *3i5 = I & x

um]Department Progrum/Department Facult

Contact

icon icon="icon: Personnel [ & WX
e | found, please create the personr

envelope-o’
round="transparen
="white" size="16"
gin="0Opx Opx Opx

6. Once there, you can edit the categories it shows. Select one in the shown box or
select multiple while holding the CTRL button.




General Style Typagraphy Shadow Spacing tem Title

Category

ou can use Cirl/Command button o select multiple items or remove the

Adminisiration
Advising Maps selected ilem. Leave this field blank to select all items in the list
Advisor

e —
Art

Associated Student Body
Automotive Technology e

Num Fetch

The number of posts showing on the personnel item

3

To edit the personnel that show in the category or to add a new category (when
adding a new department/program), contact Matt Killebrew. Please note that
categories should not be added frivolously (for example, for a temporary event or
club).

Other settings: if your page isn’t showing all of your personnel, increase the Num
Fetch amount.

Num Fetch

3
SR

If you’d like to organize your personnel differently, you can change Order By and
Order.

Order By

Fublish Date w
Order

Descending Order w

If your category has fewer than 3 personnel, you can change the Column Size under
the Style tab. If you have 1 personnel, set it to 1. If you have 2 personnel, set it to 2. If




you have 3 or more personnel, set it to 3 (do not set it higher).

Genera Style Typography Shadow Spacing tem Title

Text Align

Personnel Style

Thumbnail Size

8. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m

9. If you are finished making changes, you can click Publish and then Submit For Review.

Contact/Links Block

What and Why?



Additional Links

Program/Department Contact

B Primary@emailcom % Link

. (509) 509-5095 ]
B Building 1800

¥ Room 1800

Description: The Contact/Links Block provides contact information and additional links at the
bottom of a page (as the page footer).

Resizable: No.

Compatible Pages: Department Page, Program Page, Basic Page

Additional Notes: This is a full screen width template. This is meant to be the only page
footer template. If you’d like add/remove a section, consider using the Contact/Staff Block,

Contact/Staff/Links Block, Contact Block, or Links Block.

How?

1. Search within the Custom Templates “Contact/Links Block” (case insensitive and
partial keywords allowed)

Wrapper / Columns & Elements £ Custom Templates () Sync Templates

iFrame Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Dinader Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block




2.

3,
4.
5,

6.

Drag the template from the Custom Templates list and then drop it into a compatible
template.

Comacy/siatijLinks
Block.

Contact/Links Block Contact/Staff Block.

Jxample Title Text [su_icon icon="icon: arrow-left"

background="transparent”

color="white" size="16" margin="0px
Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem Opx Opx Opx'mrget:'self']lfsu icon]
sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur e
maximus. Curabitur ultricies a nibh convaillis sodales.

Curabitur lectus nibh, maximus ut edio quis, porta lobortis mi. Aenean purus nulla,
consequat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce
dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non
erat. Praesent eu tristique arcu, vel facilisis mi.

To edit the contact information, see Contact Block.
To edit the additional links, see Links Block.
Click Save Options and then click Save Draft.

A A el Eimlen

[¥a]
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=
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If you are finished making changes, you can click Publish and then Submit For Review.

Contact Block
What and Why?

Program/Department Contact
B Primary@email.com E Building 1800

+. (509) 509-5095 ¥ Room 1800




Description: The Contact Block provides contact information at the bottom of a page (as a
page footer).

Resizable: No.

Compatible Pages: Department Page, Program Page, Basic Page

Additional Notes: This is not a full screen width template. This is meant to be the only page
footer template. If you’d like add/remove a section, consider using the Contact/Staff Block,

Contact/Staff/Links Block, Contact/Links Block, or Links Block.

How?

1. Search within the Custom Templates “Contact Block” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ) Custom Templates () syncTemplates

iFrame Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Video Lightbox Block Fea‘:'::e':t'“ge Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Example Title Text

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem
sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur
maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla,
consequat ut ante sed, sagittis venenatis sem. Aenean non negue sapien. Fusce
dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non
erat. Praesent eu tristique arcu, vel facilisis mi.

3. To edit the Title, see the Title Element (start on step 3).
4. To edit the contact information, click the pencil icon to edit the template (orange
outline with the Icon List title)

— = T mem T

Program/Department

lconlist [ & X
[ ___]

BE Building 1800




5. To edit an item, click on one of the tabs to open/close the dropdown.

P Fan
Icon List -\i—j

Primary@email.com

(509) 509-5095

Building 1800
L ————— ]

Image

lcon

6. To edit the email address, replace the highlighted text with an email address.

lcon
fa fa-envelope

lcon Hover

Content

Primary@email.com

Caption

Link Url
mailto:Primary@email.com
Link Target

Current Screen v

Then copy the email address into the highlighted text, but put mailto: in front to




make it work as a clickable link.

lcon
fa fa-envelope

Icon Hover

Content

Primary@email.com

Caption

Link Url

mailto-Primary@email.com

Link Target

Current Screen v

7. To edit the phone number, replace the highlighted text with a phone number (in this
format).

fa fa-phone

Icon Hover
Content

(509) 509-5095
Caption

Link Url

Link Target

Current Screen v

Then copy the phone number into the highlighted text, but put tel: (or sms: for



https://developers.google.com/style/phone-numbers#:~:text=To%20format%20phone%20numbers%20in,with%20the%20four%2Ddigit%20number.
https://developers.google.com/style/phone-numbers#:~:text=To%20format%20phone%20numbers%20in,with%20the%20four%2Ddigit%20number.

texting) in front to make it work as a clickable link.

lcon

fa fa-phone

lcon Hover

Content

(509) 509-5095

Caption

Link Url

tel:(509) 509-5095

Link Target

Current Screen A

The instructions to edit the other contact information is similar, except linking it
optional. If you don’t need particular information, you can delete an entire tab by
clicking on the x.

lcon List @

Primary@email.com

(509) 5095095

®
®
Building 1800

Room 1300 ®
Click Save Options and then click Save Draft.

L
£
=




10. If you are finished making changes, you can click Publish and then Submit For Review.

If you want to add an item back, follow the steps below.
1. Click the green +.

lcon LST.

Primary@email.com
(509) 509-5095

Building 1800

N ® ® ®

Room 1800

2. Addicon text into the highlighted field. It can be one of the following bol
For email address: fa fa-envelope
For phone number: fa fa-phone
For building number: fa fa-map-signs
For room number: fa fa-building

Q.

ed:

Primary@email.com @

Image

lcott

fa fa-envelope

lcon

Content

Frimary@email.com

Caption

3. Proceed to edit the item as shown above starting at step 5.

Links Block
What and Why?

Additional Links

% Link

@ Link

Description: The Links Block lets you list additional links to other pages, media, or websites.




Resizable: No.

Compatible Pages: Department Page, Program Page, Basic Page

Additional Notes: This is not a full screen width template. This is meant to be the only page
footer template. If you’d like add/remove a section, consider using the Contact/Staff Block,

Contact/Staff/Links Block, Contact/Links Block, or Contact Block.

How?

1. Search within the Custom Templates “Links Block” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ] Custom Templates ( ) Sync Templates

iFrame Element Map Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

T o Featured Element Featured Block Personnel Card Page Personnel Bio Page

Video Lightbox Block Element

Buttons Block Content/Hours Block Links Block

Program Page Department Page

2. Dragthe template from the Custom Templates list and then drop it into a compatible
template.

Bkample Title Text [su_icon icon="icon: arrow-left"

background="transparent”
color="white" size="16" margin="0px
Ex@imple Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem Opx Opx Opx” target="self"][/su_icon]
sefl augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur Back to mainpage

mdimus. Curabitur ultricies a nibh convallis sodales.

Cabitur lectus nibh, maximus ut odio quis, porta lobertis mi. Aenean purus nulla,
cghsequat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce
pibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non

at. Praesent eu tristique arcu, vel facilisis mi.

3. To edit the Title, see the Title Element (start on step 3).




4. To edit the links, click the pencil icon to edit the template (orange outline with the
Icon List title)

tn Z & x X

Additional Links

lconList [ & WX
-y

5. Select an item to edit (click to open)

lcon List @

Link
Link
Link

Link

6. You can edit the link by editing the Icon field (highlighted) with one of the following:
For standard link: fa fa-link
For link to PDF: fa fa-file-pdf




For link to Word doc: fa fa-file-word

lcon

fa fa-file-pdf

lcon Hover

Content

Link

Cantinn

7. To change the link text (what the user will see), edit the Content field (highlighted)

Content

Link

Caption

Link Url




8. To edit the URL (where the link will go to), edit the Link URL field (highlighted). Follow
linking procedures.

Link Url

Link Target

Current Screen

9. Optional. Change the Link Target if you want the page to open in a new tab or just
change the existing page

Link Url

Link Target

Current Screen




10. If you want to add an item, click the green + and fill out the fields shown above. To
remove an item, click the red x.

Icon List (+>
-

Link

Link

® @ |

Link

11. Click Save Options and then click Save Draft.

B save Options

LA

(vt ]
o
o
o

!
o
T
1]

12. If you are finished making changes, you can click Publish and then Submit For Review.

Basic Page

What and Why?

Example Title Text € Bock to mainpage

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac
lorem sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur
maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla,
consequat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce
dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non
erat. Praesent eu tristique arcu, vel facilisis mi.

Description: The Basic Page is designed to house content that needs to be separated (either
for space, information specificity, etc.) from a landing/primary page. It can be considered a
sub-page template of sorts, but it can be used as a primary page if the Back To Page template
is replaced with a different one (see swappable elements).

Examples of usage are the Testing Center and the Art Student Gallery pages

Resizable: No.



https://www.bigbend.edu/student-center/testing-center/
https://www.bigbend.edu/academics/art-student-gallery/

Swappable Elements:
e Right section: The right section can be swapped with the following compatible
elements; Back To Page Element, Hours Element, or Contact Element.
e Other: You can add the Contact/Staff/Links Block, Contact/Staff Block, Contact Links
Block, Contact Block, or the Links Block to the bottom.
Additional Notes: this is not a full width template.
1. Search within the Custom Templates “Basic Page” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elemenis ) Custom Templates () Sync Templates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Diader Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttors Block Content/Hours Block Links Block

Program Page Department Page
2. Drag the template from the Custom Templates list and then drop it into an empty
page.

== Example Title Text [su_icon icon="icon: arrow-left"
s 1 background="transparent”

color="white" size="16" margin="

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac 0Opx Opx Opx” target="self"][/su_i

lorem sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur

Back to mainpage

maximus. Curabitur ultricies a nibh convallis sodales.




3. Click Save Options and then click Save Draft.

To edit the Title, see Title Element (start on step 3).

To edit the primary content, see Text Box Element (start on step 3). Other templates can be
added into the primary content section (gray background).

To edit the link to the primary page (blue background), see Back To Page Element.

If you are finished making changes, you can click Publish and then Submit For Review.

Content/Hours Block

What and Why?

Example Title Text

Description of what this department is and the services it offers. Lorem ipsum dolor sit amet,
consectetur adipiscing elit. Praesent ac lorem sed augue imperdiet posuere non non elit Mon-Thurs 07:30-4:300

Donec tempus sapien in erat efficitur maximus. Curabitur ultricies a nibh convallis sodales.

Friday 07:30-3:300

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla, consequat
Sat-Sun Closed®
ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce dapibus, urna ac

dictum efficitur, dui turpis molestie libero, at ultrices erat purus non erat. Praesent eu tristique

arcu, vel facilisis mi.

Description: The Content/Hours Block, similar to the Hours Element, is a convenient and
visually pleasing method to show the open hours of a service, department, or event while
also including the Default Block (this is sometimes preferable since it comes sized correctly).
Resizable: No.

Swappable Elements: The right section can be swapped with the following compatible
elements; Back To Page Element, Hours Element, or Contact Element.

Additional Notes: this is not a full width template.

How?




1. Search within the Custom Templates “Hours Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ] Custom Templates () Sync Templates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Diader Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttors Block Content/Hours Block Links Block

Department Page

Program Page

2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Hours Element Content/Hours Block

Example Title Text

Description of what this department is and the services it offers. Lorem ipsum dolor sit amet,

consectetur adipiscing elit. Praesent ac lorem sed augue imperdiet posuere non non elit. Mon-Thurs

ppearance

, Donec tempus sapien in erat efficitur maximus. Curabitur ultricies a nibh convallis sodales.
Plugins (1

sers Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla, consequat
fools ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce dapibus, urna ac Sat-Sun
bettings dictum efficitur, dui turpis molestie libero, at ultrices erat purus non erat. Praesent eu tristique

hortcodes arcu, vel facilisis mi.

To edit the non-hours content, follow the instructions for the Default Block.
To edit the hours content, follow the instructions for the Hours Element.

If you are finished making changes, you can click Publish and then Submit For Review.

Hours Element

What and Why?



Mon-Thurs 07:30-4:300

Friday 07:30-3:300

Sat-sun Closed®

Description: The Hours Element is a convenient and visually pleasing method to show the

open hours of a service, department, or event.

Resizable: No.

Compatible Pages/Blocks: This can be swapped with the right section of either Basic Page or

Default Block.

Additional Notes:

3. Search within the Custom Templates “Hours Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elemenis ) Custom Templates () Sync Templates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Diader Element Space Element Text Box Element Title Element Default Block

Featured Image

Element Featured Element Featured Block Personnel Card Page Personnel Bio Page

Video Lightbox Block

Buttors Block Content/Hours Block Links Block

Program Page Department Page
4. Dragthe template from the Custom Templates list and then drop it into a compatible
template.

Hours Element

Example Title Text Mon-Thurs 07:30-4:30 ©

Friday 07:30-3:30 ©

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac
. " " L . Sat-Sun Closed ®
lorem sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur

maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut adio quis, porta lobortis mi. Aenean purus nulla,

consequat ut ante sed, sagittis venenatis sem. Aenean non negue sapien. Fusce




5. Click the pencil icon to edit the template (orange outline with the Opening Hours title)

Opening Hours &N X 07:30-4
o

| Sat-Sun
itur

6. You can open an existing tab or add a new one.

General Style
Add New Ta@ M
Mon-Thurs @

Friday @

Sat-Sun @

B Ssave Options

7. Change the ‘Day’ value to set the days shown. Change the ‘Time’ value to set the
hours shown. Change the ‘Open’ switch to set whether the set days are open or




closed (if you set it to closed, it won’t show ‘Time’ value).
S

Mon-Thurs @

Day

Mon-Thurs
I

Time

07:30-4:30

8. Click Save Options and then click Save Draft.

9. If you are finished making changes, you can click Publish and then Submit For Review.

Buttons Block

What and Why?

Description: The Buttons Block provides a visually pleasing way to links to a collection of
pages, files, or websites. It makes use of the Button Element and is primarily used on
program pages.
Resizable: Yes. If you remove a button column (yellow outline), you can then resize the
buttons to fit.

e 4 buttons: 1/4 width each.

e 3 buttons: 1/3 width each.

e 2 buttons: 1/2 width each.




Compatible Pages: Department Page, Program Page

Additional Notes: this is not a full width template.

How?

1. Search within the Custom Templates “Buttons Block” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ) Custom Templates C ) Sync Templates

iFrame Element Map Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttons Block Content/Hours Block Links Block

Program Page Department Page
2. Dragthe template from the Custom Templates list and then drop it into a compatible
template.

Buttons Block

Example Title Text




3. Click the pencil icon to edit the template (orange outline with the Button title)

Wrapper X Z %

1 Z & x

Button [ & X




4. Change the Button Text, the Button Link, and the icon (you can search if you know
what you’re looking for). Note: there isn’t an icon for everything.

Button Text

Example Link
E———

Button Link To

Custom Url v

Button Link

#

Button Link Target

Current Screen v
Icon Position
Left v

lcon Selector

Font Awesome 5 ~
Search Icons

e ————E
8 & A I DB EBEEEOMNMHLL 2 4 B === =848 a
Bty A dmE T KN R Y D> ADEE D BB
@ ENOOOO®ORARO0DOOGO© OV ¢ > 1+ & < 1 A&
fkwe @ ANe>oOAD Q¥ WA MWF DETOE
O = @ # EoOo=E=2 0= kb @ A A XXM AM D
O# & 4 3OO0 = EELLPBDBSO 2 BY @ =L 88 -

5. Click Save Options and then click Save Draft. Repeat for each button.

B save Options

R

Save draft Preview m

6. If you are finished making changes, you can click Publish and then Submit For Review.




Button Element

What and Why?
I

B sopyow
Description: The Button element provides a visually pleasing way to link to another page, file,
or website.
Resizable: Takes the width of the container.
Compatible Templates:
e Main section of these: Department Page, Program Page, Basic Page, Personnel Bio
Page, Content/Hours Block
e Other: Card Block, Card Element, Default Block
Additional Notes: this is not a full width template.
1. Search within the Custom Templates “Button Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ) Custom Templates C ) Sync Templates

iFrame Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Element Featured Element Featured Block Personnel Card Page Personnel Bio Page

Video Lightbox Block

Content/Hours Block Links Block




Drag the template from the Custom Templates list and then drop it into a compatible
template.

Buttons Block

Example Text. Lorem ipsum dolor sit amet, ¢




3. Click the pencil icon to edit the template (orange outline with the Button title)

pearance

Example Text. Lorem ipsum d




4. Change the Button Text, the Button Link, and the icon (you can search if you know

what you’re looking for). Note: there isn’t an icon for everything.

Button Text

Example Link
EEE———

Button Link To

Custom Url v

Button Link

#

Button Link Target

Current Screen v
Icon Position
Left v

lcon Selector

Font Awesome 5 v
Search Icons

S —
5 3 AI D BEEEOOQONNELZL2ALB====84 a3,
Bty A dmE T KN R Y D> ADEE D BB
® v BN O ® 0 OO0 MO0 ®0 06O O Vv € > 1+ & o 1 &
Ak @@ NS S>DAD QW ¥ W A UWWF LHLSROm
O mm = @ £ ToOo=2=D D= Hmb B B A 4 X R MA M H
B M % &£ 30 950 = EEL PO 0 32 BY =4 8 8 -~

5. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m

6. If you are finished making changes, you can click Publish and then Submit For Review.




Card Block

What and Why?

Example Title Text

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Example Text. Lorem
ipsum dolor sit amet, consectetur adipiscing elitExample Text. Lorem ipsum dolor sit amet,
consectetur adipiscing elit.

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit Example Text. Lorem
ipsum dolor sit amet, consectetur adipiscing elit Example Text. Lorem ipsum dolor sit amet,

consectetur adipiscing elit.

& Example Link

Description: The Card Block, similar to the Card Element, is a multi-purpose template that

can link to other pages, files, or websites or show a piece of information in a visually pleasing

manner. A use cases is the Computer Science page.

Resizable: No

Compatible Pages: Department Page, Program Page, Basic Page

Additional Notes: this is not a full width template.

1. Search within the Custom Templates “Card Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ) Custom Templates C ) Sync Templates

iFrame Element Map Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Dt Featured Element Featured Block Personnel Card Page Personnel Bio Page

Video Lightbox Block

Buttons Block Content/Hours Block Links Block



https://www.bigbend.edu/academics/computer-science/

2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Example Title Text

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscir
ipsum dolor sit amet, consectetur adipiscing elit.Example Text. L
consectetur adipiscing elit.

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscir

To edit the image:
1. Click the pencil icon to edit the template (orange outline with the Image title)

Wrapper = & 2 2 X

13 Z b & x




2. Remove the current image and add a new one from the Media Library. Remember to
follow accessibility guidelines when uploading new images.

General Style Color =

Upload Image

Thumbnail Size

3. Click Save Options and then click Save Draft.

————

Save draft Preview m

To edit the title:




1. Click the pencil icon to edit the template (orange outline with the Title title)

ne memx . © Text
-

Example Text. Lorem ipsum dolor ¢
2. Change the text below. '

General

Title

Example Title Text
e

Caption

3. Click Save Options and then click Save Draft.

B Save Options

R

Save draft Preview m

To edit the text:




1. Click the pencil icon to edit the template (orange outline with the Text Box title)

Cat ¢

A

Example Title Text

TextBox [ XWX N ipsum ¢
&=
iosurn dolOr sit amet, conse:

consectetur adipiscing elit.

Example Text. Lorem ipsum ¢
ipsum dolor sit amet. conse:

Content

[ ©y Add Media ] I @ Caldera Form ] [] Insert shortcode

Visual = Text

File v Edits View s Insetv Format« Tools v Table »

v

GDLR Core v  AA~

w©
I-.'
c
i
4
i
n
L]
lih

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Example Text. Lorem ipsum dolor sit
amet, consectetur adipiscing elit. Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit.

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Example Text. Lorem ipsum dolor sit

amet. consectetur adipiscing elit. Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit.




3. Click Save Options and then click Save Draft.

To edit the button:
1. Click the pencil icon to edit the template (orange outline with the Button title)

e ————

Button [ X IEX
L]




2. Change the Button Text, the Button Link, and the icon (you can search if you know
what you’re looking for). Note: there isn’t an icon for everything.

Button Text

Example Link
EEE———

Button Link To

Custom Url v

Button Link

#

Button Link Target

Current Screen v
Icon Position
Left A

lcon Selector

Font Awesome 5 ~
Search lcons

e ————E
5 3 A I D BEEEHO0OQONMEL 2 A BB === =84§ a3,
Bty A dmE T KN R Y D> ADEE D BB
- HFRA O ® 0 000060 0 ¥ ¢€ > 1 &« 1 A
¥k @B ANS>DOAQO QW § WG UL EBDHOm
O = @ # EoOo=E=2 0= kb @ A A XXM AM D
B iM% 4 3900 % EELL P S6 O 32 BYaed—=o BB B -

3. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m

4. |If you are finished making changes, you can click Publish and then Submit For Review.




Card Element

What and Why?

Example Title Text

Example Text. Lorem ipsum dolor sit amet,
consectetur adipiscing elit.

Description: The Card Element, similar to the Card Block, is a multi-purpose template that
can link to other pages, files, or websites or show a piece of information in a visually pleasing
manner. A use cases is the President’s Cabinet page.
Resizable: Yes.

e 4 cards: 1/4.

e 3cards: 1/3.

e 2 cards: 1/2.
Compatible Pages: Department Page, Program Page, Basic Page
Additional Notes: this is not a full width template.

How?

3. Search within the Custom Templates “Card Element” (case insensitive and partial
keywords allowed)

rapper / Columns : lemen 'om Tem Sync Templates
B w / Col & Eements ) Custom Tel ) Sync Templaty

iFrame Element Map Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image
Element

Video Lightbox Black

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block



https://www.bigbend.edu/about-us/presidents-cabinet/

4. Dragthe template from the Custom Templates list and then drop it into a compatible
template.

To edit the image:
4. Click the pencil icon to edit the template (orange outline with the Image title)




5. Remove the current image and add a new one from the Media Library. Remember to
follow accessibility guidelines when uploading new images.

General Style Color =

Upload Image

Thumbnail Size

6. Click Save Options and then click Save Draft.

————

Save draft Preview m

To edit the title:




4. Click the pencil icon to edit the template (orange outline with the Title title)
Ll g ;

Salppte)icy e Text
L

Example Text. Lorem ipsum

consectetur adiniscina elit.
5. Change the text below. _

General Style Typography

Title

Example Title Text
EEeeer————oeee

Caption

6. Click Save Options and then click Save Draft.

B save Options

O

Save draft Preview m

To edit the text:




4. Click the pencil icon to edit the template (orange outline with the Text Box title)

Example Title Text

TextBox b WX M ipsum dolc
uuuuuuuuuuuuuuu ~iccing elit.

& Example Link

5. Change the text below.
Content

O3 Add Media | | @ _Caldera Form | [J Insert shortcode

File v Edity View v Insert Format« Tools v Table v
B I U &= v

- 7, v bR 2 2 [

i
4
I
[l
lili

GDLR Core » AR~

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit.

S




6. Click Save Options and then click Save Draft.

To edit the button:
5. Click the pencil icon to edit the template (orange outline with the Button title)

Example Text. Lorem ipsur

consectetur adipiscing el




6. Change the Button Text, the Button Link, and the icon (you can search if you know
what you’re looking for). Note: there isn’t an icon for everything.

Button Text

Example Link
EEE———

Button Link To

Custom Url v

Button Link

#

Button Link Target

Current Screen v
Icon Position
Left v

lcon Selector

Font Awesome 5 v
Search Icons

S —
5 3 AI D BEEEOOQONNELZL2ALB====84 a3,
Bty A dmE T KN R Y D> ADEE D BB
@ BN O ®0 000 OO0 GO OV € > 1+ & —~ 1 &
Ak @@ A S>DOAD Q¥ ¥ W AWML EHTJDOm
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7. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m

8. |If you are finished making changes, you can click Publish and then Submit For Review.




Personnel Bio Page
What and Why?

=
=

About

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Example Text. Lorem
ipsum dolor sit amet, consectetur adipiscing elit.Example Text. Lorem ipsum dolor sit amet,
consectetur adipiscing elit.

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elitExample Text. Lorem
ipsum dolor sit amet, consectetur adipiscing elit. Example Text. Lorem ipsum dolor sit amet,
consectetur adipiscing elit.

Custom Element List

Description: The Personnel Bio Page is a page template for the linkable Personnel. Some
pages have their Contact/Staff Block and Contact/Staff/Links Block clickable to go to Bio
pages, but for personnel who don’t have bios, the Personnel Card Page is to be used.
Resizable: No.

Additional Notes: this is not a full width template. Only to be used on Personnel pages, it
does not work properly otherwise (note: these are not in the standard access).

1. Search within the Custom Templates “Personnel Bio Page” (case insensitive and
partial keywords allowed)

Wrapper / Columns & Elements @ Custom Templates () Sync Templates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Diader Element Space Element Text Box Element Title Element Default Block

Video Lightbox Block Fea‘;‘::g'r"'l'“ge Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttors Block Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible

About

Example Text. Lorem
ipsum dolor sit amet
consectetur adipiscil

To edit the image:
1. To edit the image, click the pencil icon to edit the image (orange outline with the

Image title). Remember to follow accessibility guidelines when uploading new images.

T3 Z & X x

Image [ XWX
=1




2. Click Save Options and then click Save Draft.

To edit the large text:
1. To edit the large text, click the pencil icon to edit the template (orange outline with
the Title title)

tos Z L x

Title X hx
-

Example Text. Lorem ipsum ¢
ipsum dolor sit amet, conset
consectetur adipiscing elit.




2. Change the text below.

General

Title

About
e

Caption

3. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m

To edit the bio content:




1. To edit the bio content, click the pencil icon to edit the template (orange outline with
the Text Box title)

ta3 Z W & x

About

Text Box FAEX N ipsur

L
ipsum dolr sit amet, con

consectetur adipiscing eli

Example Text. Lorem ipsur
ipsum dolor sit amet, con




2. Change the bio text.

General

Content
Text

Q3 Add Media ] [ @ Caldera Form I [ ] Insert shoricode

Format v Tools v Table w
GDLR Core v AR~

File v Edite Vieww Inser«

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Example Text. Lorem ipsum dolor sit

amet, consectetur adipiscing elit. Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit.

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Example Text. Lorem ipsum dolor sit
amet, consectetur adipiscing elit. Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit.

3. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m
L

4. If you are finished making changes, you can click Publish and then Submit For Review.

Personnel Card Page
What and Why?




)

‘

2/

2

Custom Element List

Description: The Personnel Card Page is a page template for the linkable Personnel. Some
pages have their Contact/Staff Block and Contact/Staff/Links Block clickable to go to Bio

pages, but for personnel who don’t have bios, the Personnel Card Page is to be used.

Resizable: No.
Additional Notes: this is not a full width template. Only to be used on Personnel pages, it
does not work properly otherwise (note: these are not in the standard access).

1. Search within the Custom Templates “Personnel Card Page” (case insensitive and
partial keywords allowed)

Wrapper / Columns & Elements ) Custom Templates ( ) Sync Templates

iFrame Element Map Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Element Featured Element Featured Block Personnel Card Page Personnel Bio Page

Video Lightbox Block

Buttons Block Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Personnel Card Page Personnel Bio Page

This option will show selected
personnel information on front end

areaq.

3. Click the pencil icon to edit the image (orange outline with the Image title).
Remember to follow accessibility guidelines when uploading new images.

1
[
v/ /./"
4. The template pulls information from the Personnel page. If you’d like to change the

values that show, you’ll need to scroll down and change these values (only available
on Personnel pages). Note: the personnel name is changed by changing the Personnel




page title.

Show WordFress bditor Content

Disable this to hide the conte;
ON

Position

Title V Grants

—

Email

elijahb@bigbend.edu

o,

Phone

(509) 793-2198

—

Location

Room 1851

S———

Excerpt

5. Click Save Options and then click Save Draft.

B save Options

[¥a]
[vF]
=
i
o
o
|
L
T
o

6. If you are finished making changes, you can click Publish.

Featured Block

What and Why?



’ Featured Block

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.
Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute
irure dolor in reprehenderit in voluptate velit esse cillum dolore eu fugiat nulla pariatur. Excepteur sint occaecat cupidatat
non proident, sunt in culpa qui officia deserunt mollit anim id est laborum.

Learn More

Description: The Featured Block was designed after the Featured Element to provide a
method to show a piece of information in an appealing method. It has many of the same
elements, but is built to better display more text (it also doesn’t have the hover animation).
Resizable: Yes.

e 1 blocks: 1/1.

e 2 blocks: 1/2.
Compatible Pages: Department Page, Program Page
Additional Notes: this is not a full width template. This is not to show a temporary
notification, use the Alert Box Element instead.

1. Search within the Custom Templates “Featured Block” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ) Custom Templates () Sync Templates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttors Block Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Featured Image

Featured Element Featured Block
Element

B Apply Now

’ Featured Block

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eius
enim ad minim veniam, quis nostrud exercitation ullamco laboris n
in reprehenderit in voluptate velit esse cillum dolore eu fugiat nulla

mmt im sl i saffisis Alansrimt meallit samiee s et leibse ime




3. Click the pencil icon to edit the template (orange outline with the Column Service
title)

Wrapper = & 2 & x

* 11 = & & x

Column Service AIEx
L]

Lorem ipsum dolor sit amet, consectetur a

ock

enim ad minim veniam, quis nostrud exerc
in reprehenderit in voluptate velit esse cillL

sunt in culpa qui officia deserunt mollit ani

4. To edit the title, change the value under Title. To edit the content, change the value
under Content (do not put all of your page text into here). To change the link, change
the value under Read More Link and change the text under Ream More Text (to




change what text shows).

Title

Featured Block

Caption

Caption Position

Boitom w

Content

q: Add Madia [] Insert shorteode

idera Forn . —
|ﬂCaj_a orm Visua =)

File » Edit » View » Insert+ Format » Tools » Table «

B I U =~ £~ = = = GDLR Core »  mA~

Forem ipsum dolor sit amet, consectetur adipiscing elit. sed do elusmod tempor incididunt ut labore et delore
magna aligua. Ut enim ad minim veniam, quis nostrud exercitation ullameo laboris nisi ut aliquip ex ea
commodo consequat. Duis aute irure dolor in reprehenderit in voluptate velit esse cillum dolore eu fugiat nulla
pariatur. Excepteur sint occaecat cupidatat non proident, sunt in culpa qui officia deserunt mollit anim id est

Read More Text

Leam More
L

Read More Link




5. To change the icon, select one from the list shown (you can use the search if you
know what you’re looking for. Note: there is not an icon for everything).

lcon

Font Awesome 5 v

wl

B E RERFENA®»O@OCO6 Q0UWSCOE@e onn & -
S A @ QMmO Ee 191 ~—->tymoAZzEETY A
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¥ %O 9 acBE ok

6. Click Save Options and then click Save Draft.

L1
[vF]
=
o
=]
%]

|

7. If you are finished making changes, you can click Publish and then Submit For Review.

Featured Element

What and Why?

F

Resource

Description: The Featured Element provides a visually pleasing alternative to the Button
Element. Similarly, it links to another page, document, or external page, but the differences
are that it looks different (larger icon, more space, a hover animation similar to the Buttons
Block buttons) and that it also has a section for a description.
Resizable: Yes.

e 4elements: 1/4.

e 3elements: 1/3.




e 2elements: 1/2.

e Fills width if taken out of column (can be done in some cases).
Compatible Pages(or Blocks if taken out of column):

e Pages: Department Page, Program Page, Basic Page

e Blocks (if taken out of column): Content/Hours Block, Default Block

Additional Notes: this is not a full width template.

How?

1. Search within the Custom Templates “Featured Element” (case insensitive and partial
keywords allowed)

rapper olumns 5 iemeni ustom lemj 85 Sync Templates
[E wrapper/ Col & B ts ] Custom Te () Sync Templat

iFrame Element Map Hement Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image
Element

Video Lightbox Block

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Ulashboarg
Goodlayers

| WP Activity Log
Featured Element

Posts

Comments

Personnel

E Apply Now

M.E. Calendar
Header
Ninja Forms

Caldera Forms

Appearance

= & X

1 = & & x

Wrapper

Featured Box [ X |EX
-

Y

4. To edit the title, change the value under Title. To edit the content, change the value
under Content (avoid putting more than just a sentence or two in here). To change




the link, change the value under Item Link URL.

Title

Resource

—————————

Caption

Content

Q7 Add Media ‘ | @ Caldera Form | L LS

File » Edit« WView » Inserf« Format« Tools » Table »
B I U =~ =+~

£ 3 E o B R[]

Short description of resource

Button Link To

Custom Url b

Item Link URL

GDLR Core »

f




5. To change the icon, select one from the list shown (you can use the search if you
know what you’re looking for. Note: there is not an icon for everything).

lcon

Font Awesome 5 v

W

BE DD EWAOP @O0 O OUTWNSCOROODD § -
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Title

Resource

6. Click Save Options and then click Save Draft.

L
[wF]
=
It
o
o
|
L
o
o

7. If you are finished making changes, you can click Publish and then Submit For Review.

Featured Image Element
What and Why?

Resource

short description of resource

Description: The Featured Image Element works similarly to the Featured Element in that it’s
a visually appealing way to link to a different page, document, or site. The difference is
primarily visual with the Featured Image Element using a background image and doesn’t use
an icon nor does it have the hover effect. This is primarily used in high level navigation pages
such as | Am, Academics, etc.



https://www.bigbend.edu/i-am/
https://www.bigbend.edu/academics/

Resizable: Yes.
e 4elements: 1/4.
e 3elements: 1/3.
e 2elements: 1/2.
e Fills width if taken out of column (not recommended).
Compatible Pages(or Blocks if taken out of column):
e Pages: Department Page, Program Page, Basic Page
e Blocks (if taken out of column): Content/Hours Block, Default Block
Additional Notes: The Featured Image Element aren’t used commonly and were only made
to be a variant of the Featured Element. In nearly all cases, it's recommended that you use
the Featured Element instead.
1. Search within the Custom Templates “Featured Image Element” (case insensitive and
partial keywords allowed)

Wrapper f Columns & Elements @) Custom Templates C ) Sync Templates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

‘White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttons Block Content/Hours Block Links Block




Drag the template from the Custom Templates list and then drop it into a compatible
template.

Featured Element

B Apply Now

Resource

Short description of resource

Example Title Text




3. Click the pencil icon to edit the template (orange outline with the Featured Box title)

Wrapper Z & & & x

13 Z & & x

Featured B x
caturedBox [ L&

Resource

Short description of resource

Example Title Text

4. To edit the title, change the value under Title. To edit the content, change the value
under Content (avoid putting more than just a sentence or two in here). To change




the link, change the value under Item Link URL.

Title

Resource

—————————

Caption

Content

Q7 Add Media ‘ | @ Caldera Form | L LS

File » Edit« WView » Inserf« Format« Tools » Table »
B I U =~ =+~

£ 3 E o B R[]

Short description of resource

Button Link To

Custom Url b

Item Link URL

GDLR Core »

f




5. To change the background image, go to Background Style, and select a new image
under Background Image (be sure to follow accessibility guidelines when uploading a

new image).

General Typography Color Background Style Spacing
—

Sync Height

Use to sync the height among an items
boxes-1 . ) :
be fixed so be cautious not to use it on

Positioning Content In The Middle Of This ltem { When sync hieght is being used )

ON I

Background Image

B A

<

Background Opacity

6. Click Save Options and then click Save Draft.

B save Options

E—————

Save draft Preview m

7. If you are finished making changes, you can click Publish and then Submit For Review.




Video Lightbox Block
What and Why?

®

See What It's All About

See morevideos

Description: The Video Lightbox let’s you display a video in a lightbox form. This is more
attractive than the regular Video Element template, but takes more room.

Resizable: No.

Compatible Pages: Department Page, Program Page
Additional Notes: This is a full screen width template.

To add the video lightbox and edit the video it opens:
1. Search within the Custom Templates “Video Lightbox Block” (case insensitive and

partial keywords allowed)

Wrapper / Columns & Elements ) Custom Templates ( ) Sync Templates

iFrame Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Video Lightbox Block Fea‘:'::e'r"’t'“ge Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Example Title Text

Description of what this program is and the expected outcor
augue imperdiet posuere non non elit. Donec tempus sapier

Curabitur lectus nibh, maximus ut odio guis, porta lobortis m
neque sapien. Fusce dapibus, urna ac dictum efficitur, dui tu
facilisis mi.

3. To edit the video that shows up when a user clicks on the play image, click this pencil
icon (orange outline with the Image title)




t1n Z & & x X

Image @& & 1EXx
=]

Then scroll down to ‘Video URL’ and paste your link there (must be a YouTube or
Vimeo link).

Link To

Video Lightbox w

Video Url { Youtube / Vimeo )

hitps-/fyoutu. befilITODhzHas
L e

Overlay Icon

Mo Overlay w

4. Click Save Options and then click Save Draft.

R

Save draft Preview m

5. If you are finished making changes, you can click Publish and then Submit For Review.




To edit the large text:
1. Click this pencil icon (orange outline with the Title title)

2. Update this text here. Be sure to keep it concise and short (for mobile friendliness).

Leneral STyie Iypograpny _o1or
Title
See What It's All About
Caption




3. Click Save Options and then click Save Draft.

B save Options

————

Save draft Preview m

To change the ‘See more videos’ link:
1. Click this pencil icon (orange outline with the Text Box title)

TextBox @ X IEX
=51




2. Click on the text and click on the pencil icon that appears.

| 9 Add Media

| @ Caldera Form

Euizvgzvﬂ'j GDL
= 2 E 0 HE(P R B

| [ ] Insert shortcode

See more tlideos

¢t g R

3. Replace the # to your new link and click the return icon.
| q; Add Media | | @ _Caldera Form | L] Insert shortcode

u =+ =+ [] © GDLR Core v  MAw
=T @0 EPR e

See more videos

hitps://dev. bigbend. edu/academigs/art/ Iﬂ-ﬁ-




4. Click Save Options and then click Save Draft.

B save Options

————

Save draft Preview m

To change the lightbox background image:
1. Click this pencil icon (yellow outline with the 1/1 title)

tan Z B & x X
-




2. Go to the Background tab and scroll down to the ‘Background Image’ section. Click
the x to remove the current background.

Genera Background Border Spacing Custom Skin

——

Full Height Wrapper

m
i)
5]
I
4
]
o
m
n
1
i
]

Sync Height
Use 10 sync the heignt amon
be fixed so be cautious not £
Positioning Content In The Middle Of This Item { When sync hieght / Full height is being uses

OFF

Background Type

Image v

Background Color Type

Plain Color v

Background Extending

Mone v

Background Color

Can also be use as a base oo
- Select Color
Background Imaae

o




3. Click the plus to add a new image from the Media Library. (If adding a new image,
follow the Media upload and accessibility instructions)

Background Image

+ —
Background Image Style

Do not change the other settings.
4. Click Save Options and then click Save Draft.

Video Element
What and Why?

8’ Big Bend Community College - Find Your Career,




Description: The Video Element lets you place a video into the webpage.
Resizable: Takes the width of the container.
Compatible Templates:

e Main section of these: Department Page, Program Page, Basic Page, Personnel Bio

Page, Content/Hours Block

e Other: Default Block
Additional Notes: The Video Element supports self-hosted video links (from the Media
Library), YouTube links, and Vimeo links. If you’re video is hosted on a source other than
these (Panopto, etc.), you will have to use the iFrame Element instead.

How?

1. Search within the Custom Templates “Video Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ] Custom Templates () Sync Templates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Diader Element Space Element Text Box Element Title Element Default Block

Video Lightbox Block Fe"";"::e'r':t'“ge Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttors Block Content/Hours Block Links Block




Drag the template from the Custom Templates list and then drop it into a compatible
template. (if it looks short vertically right away, don’t worry, it’s just a rendering bug.)

Video Element Video Lightbox Block

mple Title Text

ple Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac

4
by
c
0
B

sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur
us. Curabitur ultricies a nibh convallis sodales.

Curglbitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla,
corsequat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce
ibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non
erfit. Praesent eu tristique arcu, vel facilisis mi.

6" Big Bend Community College - Find Your Career © ~»
Watch later ~ Share

Click the pencil icon to edit the template (orange outline with the Video title)
CIUL TITUucocTlitTu u IDLI\.{UC Uieu, vOI 1ULCIIDIO 11

Video [ XIEX
=

pmmunity College - Find Your Care

Select the ‘Video Type’. Self-Hosted Video means you’ll be using a video uploaded to
the Media Library (it’s advised that you don’t use this option). YouTube means you'll
be linking a video hosted on YouTube. The V means you’ll be linking a video hosted on




Vimeo.

None v cetfings at the =T

Video Type

S|

HTML 5

Self-Hosted Video

Video URL

hitps:/fyoutu.befiUITODhzHas

Autoplay

5. Once you’ve selected the correct ‘Video Type’, enter a link into the ‘Video URL'.
None ¥ setfings at the "Tt

Video Type

S|

HTML 5

Self-Hosted Video

Video URL

hitps:/fyoutu. befiUITODhzHas

ﬁ

Autoplay

6. There are optional settings such as autoplay and loop. Do not enable these.




7. Click Save Options and then click Save Draft.

8. If you are finished making changes, you can click Publish and then Submit For Review.

Gallery Element
What and Why?

Description: The Gallery Element provides a compact method to store multiple images on
one page.
Resizable: Takes the width of the container.
Compatible Templates:
e Main section of these: Department Page, Program Page, Basic Page, Content/Hours

Block
e Other: Default Block
Additional Notes: If adding a gallery to a page, it's recommended that you keep the number
of images 9 or lower. If you would like to have more images, it’s recommended that you
create a separate gallery page.
It's recommended that you don’t change the other settings in the Gallery Element.




How?

template.

Video Lightbox Block

1. Search within the Custom Templates “Gallery Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns &% Elements ) Custom Templates C ) Sync Templates

iFrame Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

e Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block

y Log Gallery Hement

mple Title Text

ple Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem
ugue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur
us. Curabitur ultricies a nibh convallis sodales.

Cur
con

itur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla,
quat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce dapibus,
urncac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non erat.

ent eu tristique arcuy, vel facilisis mi.




3. Click the pencil icon to edit the template (orange outline with the Gallery title)

Gallery [ X IEXx
=

4. To add new images to the gallery, click the plus icon and select images from the
Media Library. (If adding a new image, follow the Media upload and accessibility
instructions.)

Random Order




5. To delete an image from the gallery, hover over an image and click the red x.

<3

6. To rearrange the gallery, simply click and drag the images.

Random Order

7. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m

8. If you are finished making changes, you can click Publish and then Submit For Review.




Image Element
What and Why?

)

1

2/

4

Description: The Image Element let’s you post images in a webpage.
Resizable: Takes the width of the container.
Compatible Templates:
e Main section of these: Department Page, Program Page, Basic Page, Personnel Bio

Page, Content/Hours Block

e Other: Default Block
Additional Notes:

1. Search within the Custom Templates “Image Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ) Custom Templates () Sync Templates

iFrame Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Diader Element Space Element Text Box Element Title Element Default Block

Video Lightbox Block Fe"";‘::g'r"'l'“ge Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block




Drag the template from the Custom Templates list and then drop it into a compatible
template.

Image Element

Example Title Text

ample Text. Lorem ipsum dolor sit amet, consectetur adipiscil
d augue imperdiet posuere non non elit. Donec tempus sapie
ximus. Curabitur ultricies a nibh convallis sodales.

Cabitur lectus nibh, maximus ut odio quis, porta lobortis mi. A
equat ut ante sed, sagittis venenatis sem. Aenean non nec
ac dictum efficitur, dui turpis molestie libero, at ultrices erc
u tristique arcu, vel facilisis mi.




3. Click the pencil icon to edit the template (orange outline with the Image title)

Image EII' 3 1l x
/

4. To change the image shown, click the minus icon and then the plus. (If adding a new
image, follow the Media upload and accessibility instructions.)

Upload Image

a N
Thumbnail Size

5. Optional Settings: if you want the image to link to a document or website, change the
‘Link To’ to ‘Custom URL'. If you want the image to show captions, toggle ‘Enable




Captions’ on.

Fill the number fo position
applied to front end of the !

Link To

Lightbox with full image w
Overlay lcon

Mo Overlay v

Enable Caption

6. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m

7. If you are finished making changes, you can click Publish and then Submit For Review.

Default Block

What and Why?

Example Title Text

Description of what this program is and the expected outcomes. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem
sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla, consequat ut ante sed, sagittis venenatis sem. Aenean non
neque sapien. Fusce dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non erat. Praesent eu tristique arcu, vel
facilisis mi.

Description: The Default Block is a starting point for custom pages (custom pages should only
be made by individuals who are experienced web development) or to replace different blocks




(for example if you have the Content/Hours Block, but don’t need the hour information
anymore). It uses the Title Element, Text Box Element, and Space Element.
Resizable: Yes.

e 1/1 as the default.

e 2/3if being paired with Back To Page Element, Hours Element, or Contact Element.
Compatible Pages:

e Main section of these: Department Page, Program Page
Additional Notes: this is not a full width template.
To place the template in the page builder.

1. Search within the Custom Templates “Default Block” (case insensitive and partial

keywords allowed)

Wrapper / Columns & Elements @) Custom Templates () syncTemplates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

‘White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttons Block Content/Hours Block Links Block

Program Page Department Page
2. Dragthe template from the Custom Templates list and then drop it into a compatible
template.

Default Block

= Example Title Text

Description of what this program is and the expected outcomes. Lorem ipsum dolor sit amet, consecte
— augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur maximus. Curabitur ultrici

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla, consequat ut ante s
neque sapien. Fusce dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus r
facilisis mi.




3. Click Save Options and then click Save Draft.

4. If you are finished making changes, you can click Publish and then Submit For Review.

To edit the Title Element, follow these instructions.
To edit the Text Box Element, follow these instructions.

Title Element

What and Why?

Example Title Text

Description: The Title Element is used to label a section within a page.
Resizable: Takes the width of the container.
Compatible Templates:

e Main section of these: Department Page, Program Page, Basic Page, Personnel Bio

Page, Content/Hours Block

e Other: Card Block, Card Element, Default Block
Additional Notes: Do not have more than a few words as the title. This is not to be used as a
sentence/statement to make an announcement of sorts (use the Alert Box Element instead).
It is only for labeling purposes.

This is okay.




Allied Health

+ First Aid

+ Health Education

+ Medical Assistant

+ Nursing

+ Nursing Assistant-Certified

+ Physical Education

Humanities
e ——

Due to Covid-19, we're not offering services on campus Co
currently!!!!

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac

lorem sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur (%
maximus. Curabitur ultricies a nibh convallis sodales.




1. Search within the Custom Templates “Title Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ] Custom Templates () Sync Templates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Diader Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttors Block Content/Hours Block Links Block

Department Page

Program Page

2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Title Element

L e P [ [ R — e e R —




3. Click the pencil icon to edit the template (orange outline with the Title title).

e S e Text
L]

Example Text. Lorem ipsum dolor sit amet, cons
sed augue imperdiet posuere non non elit. Don
maximus. Curabitur ultricies a nibh convallis so

4. Change the Title text

Title

Example Title Text
]

Caption

5. Click Save Options and then click Save Draft.

6. If you are finished making changes, you can click Publish and then Submit For Review.

Text Box Element

What and Why?



Description of what this program is and the expected outcomes. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem
sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla, consequat Ut ante sed, sagittis venenatis sem. Aenean non
neque sapien. Fusce dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non erat. Praesent eu tristique arcu, vel
facilisis mi

Description: The Text Box Element is what lets you have text content on a webpage.
Resizable: Takes the width of the container.
Compatible Templates:
e Main section of these: Department Page, Program Page, Basic Page, Personnel Bio
Page, Content/Hours Block
e Other: Card Block, Card Element, Default Block
Additional Notes:
1. Search within the Custom Templates “Text Box Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ] Custom Templates () syncTemplates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

‘White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

deatus s and Featured Element Featured Block Personnel Card Page Personnel Bio Page

Video Lightbox Block Element

Buttons Block Content/Hours Block Links Block




Drag the template from the Custom Templates list and then drop it into a compatible
template.

Text Box Element

flera Forms Ex@gmple Title Text

earance

. Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem
= sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur

Is maximus. Curabitur ultricies a nibh convaillis sodales.

Click the pencil icon to edit the template (orange outline with the Text Box title)

TextBox [ & X N ipsum dolor sit amet, consecte
- \wclaiet posuere non non elit. Donec te

maximus. Curabitur ultricies a nibh convallis sodale

Curabitur lectus nibh, maximus ut odio quis, porta Ic
consequat ut ante sed, sagittis venenatis sem. Aene
urna ac dictum efficitur, dui turpis molestie libero, a

Praesent eu tristiaue arcu. vel facilisis mi.




4. Change the text content as needed. Be sure to follow formatting and accessibility
instructions.

Content

[ 0 Add Media ] [g. Caldera Form I 1) hsEE e Visual

Text

File v Editw View» Inseris Formate Tools v Table »

B I U =~ &=+ = = = GDLRCore v | A~

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem sed augue imperdiet
posuere non non elit. Donec tempus sapien in erat efficitur maximus. Curabitur ultricies a nibh convallis sodales.

sagittis venenatis sem. Aenean non neque sapien. Fusce dapibus, urna ac dictum efficitur, dui turpis molestie
rices erat purus non erat. Praesent eu tristique arcu, vel facilisis mi.

5. Click Save Options and then click Save Draft.

6. If you are finished making changes, you can click Publish and then Submit For Review.

Space Element

What and Why?

Description: The Space Element is for adding space within content where needed.
Resizable: Takes the width of the container.
Compatible Templates:
e Main section of these: Department Page, Program Page, Basic Page, Personnel Bio
Page, Content/Hours Block
e Other: Card Block, Card Element, Default Block
Additional Notes:

How?




1. Search within the Custom Templates “Space Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ] Custom Templates () Sync Templates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Diader Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttors Block Content/Hours Block Links Block

je Li
nments
onnel
Calendar H
ample Title Text

pder
a Forms

Exfgmple Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem
dera Forms

sefl augue imperdiet posuere non nen elit. Donec tempus sapien in erat efficitur
mgximus. Curabitur ultricies a nibh convallis sodales.
jgins

Cyrabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla,
rs

cghsequat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce dapibus,
ls ) o N . - .

urfa ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non erat.
a8 Pghiesent eu tristique arcu, vel facilisis mi.
tom Fields
pricodes
Mail SMTP

Examnple Text. Lorem insum dolor sit amet. consectetur adiniscina elit. Praesent ac lorem




3. Click Save Options and then click Save Draft.

————

Save draft Preview m

4. If you are finished making changes, you can click Publish and then Submit For Review.

Divider Element

What and Why?

Description: The Divider Element is for separating sections within content where needed.
Resizable: Takes the width of the container.
Compatible Templates:
e Main section of these: Department Page, Program Page, Basic Page, Personnel Bio
Page, Content/Hours Block
e Other: Card Block, Card Element, Default Block

Additional Notes:

1. Search within the Custom Templates “Divider Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ) Custom Templates C ) Sync Templates

iFrame Element Map Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttons Block Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Accordion Element. White Divider Element

Exfample Title Text Contact Text

Exarpple Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem [su_icon icon="icon: envelope
sed fugue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur background="transparent”
maxfmus. Curabitur ultricies a nibh convallis sodales. color="white" size="16" margin

Opx Opx Opx’][/su_icon]

Curgpitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nullg, Primary@email.com

congequat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce dapibus,
urnciac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non erat. [su_icon icon="icon: phone”
Praggent eu tristique arcu, vel facilisis mi. background="transparent”

color="white" size="16" margin
Opx 0px 0px’][/su_icon] (509)
5095

3. Click Save Options and then click Save Draft.

4. If you are finished making changes, you can click Publish and then Submit For Review.

White Divider Element

What and Why?

Description: The White Divider Element is for separating sections within content where
needed. It functions similarly to the Divider Element, but it is white to provide contrast with
dark background like the Big Bend blue and Big Bend green. The White Divider Element
should only be used with the compatible templates to combine several of them together.
Resizable: Takes the width of the container.




Compatible Templates:
e Blue section of these Pages/Blocks: Basic Page, Content/Hours Block
e Elements: Hours Element, Contact Element

Additional Notes: *black background added to show divider

1. Search within the Custom Templates “White Divider Element” (case insensitive and
partial keywords allowed)

Wrapper / Columns & Elements @ Custom Templates () syncTemplates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Diader Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttors Block Content/Hours Block Links Block

Program Page Department Page

2. Using the Basic Page template as an example, we’re going to combine the contact
information with the Hours Element (please note that you should use the page footer
blocks instead of trying to combine several of the compatible templates).

Mon-Thurs 07:30-4:30 ®

Friday 07:30-3:30 ®

Sat-Sun Closed ®

Divider [ & I %
Example Title Text Contact Text
Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem [st _icon icon="icon: envelope-o"

sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur

maximus. Curabitur ultricies a nibh convallis sodales.

3. Drag the hours information (orange outline with the Opening Hours title) to right
below the contact information (orange outline with the Text Box title) and then place




the White Divider Element (orange outline _with the Div_id_er title)_. _

Opx Opx Opx’|[/su_icon] (509) 509-
5095

[su_icon icon="icon: building-o"
background="transparent”
color="white" size="16" margin="0px
Opx Opx Opx’][/su_icon] Building 1800

[su_icon icon="icon: map-signs"
background="transparent”
color="white" size="16" margin="0px
Opx Opx Opx*][/su_icon] Room 1800

Mon-Thurs 07:30-4:30 (®

Friday 07:30-3:30 ©®

Sat-Sun Closed ®

4. Delete the remaining empty template.

*a = L

X
L]




5. Click Save Options and then click Save Draft.

[v¥]
I'-L'I

6. Here is a preview of how it looks on the frontend (Preview->Preview in new tab).

Example Title Text Contact Text

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac M Primary@emgail.com
lorem sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur
maximus. Curabitur ultricies a nibh convallis sodales. (509) 509-5095

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla,
consequat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce Building 1800
dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non
erat. Praesent eu tristique arcu, vel facilisis mi. Roomn 1800

+ Dropdown Title Mon-Thurs 07:30-4:300

Friday 07:30-3:300

Sat-Sun Closed®

7. If you are finished making changes, you can click Publish and then Submit For Review.

Dropdown Element

What and Why?

+ Dropdown Title

Description: The Dropdown Element is a convenient way to store a collection of information
into a small amount of space.
Resizable: Takes the width of the container.
Compatible Templates:

e Main section of these: Department Page, Program Page, Basic Page, Personnel Bio

Page, Content/Hours Block

e Other: Default Block
Additional Notes: Do not put a Dropdown Element inside of a Toggle Box Element or an
Accordion Element.




How?

1. Search within the Custom Templates “Dropdown Element” (case insensitive and
partial keywords allowed)

Wrapper / Columns &% Elements ) Custom Templates C ) Sync Templates

iFrame Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image
Element

Video Lightbox Block Featured Element Featured Block Personnel Card Page Personnel Bio Page

Hours Element Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

ample Title Text

Exafpple Text. Lorem ipsum dolor sit amet, consectetur adipiscing
sed fugue imperdiet posuere non non elit. Donec tempus sapien
us. Curabitur ultricies a nibh convallis sodales.

jtur lectus nibh, maximus ut odio quis, porta lobortis mi. Aer
uat ut ante sed, sagittis venenatis sem. Aenean non neque
dictum efficitur, dui turpis molestie libero, at ultrices erat |
Praesdint eu tristique arcu, vel facilisis mi.

[su_spoiler title="Dropdown Title"]

Dropdown Content
3. Click the pencil icon to edit the template (orange outline with the Text Box title)

@ & @x 'ropdown Title']
=
Dropdown Content

Text Box

[/su_spoiler]




4. To change the dropdown title, edit the highlighted text (don’t remove the quotation
marks).

= 2 W o BRI R
[su_spoiler title="Dropdown Title"]
Dropdown Content

[/su_spoiler]

5. To change the dropdown content, edit the highlighted text.

= 2T W HBRE IR
[su_spoiler title="Dropdown Title"]
Dropdown Content

[/su_spoiler]

6. To add another dropdown, you can copy page the shown text on a new line or, the
better option, duplicate the template (this will let you easily swap/delete them later if
need be).




[su_spoiler title="Dropdown Title"]

Dropdown Content

[/su_spoiler]

TexBoy | o & @x 'ropdown Title']
-

Dropdown Content

[/su_spoiler]

7. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m

8. If you are finished making changes, you can click Publish and then Submit For Review.

Toggle Box Element

What and Why?



= A TOGGLE BOX TITLE

A toggle box content area

+ A TOGGLE BOX TITLE

Description: The Toggle Box Element is a convenient way to store a collection of information
into a small amount of space. The Toggle Box Element is similar to the Dropdown Element in
functionality, but is easier to use as it doesn’t rely on shortcodes and is more aesthetically
pleasing. This is the recommended template versus the Dropdown Element.
Resizable: Takes the width of the container.
Compatible Templates:

e Main section of these: Department Page, Program Page, Basic Page, Personnel Bio

Page, Content/Hours Block

e Other: Default Block
Additional Notes: Be careful to be sure you paste content without external formatting (paste
as plain text). There is an issue that could potentially could cause the template to be
unopenable with some formatting (this issue is being investigated).

1. Search within the Custom Templates “Toggle Box Element” (case insensitive and
partial keywords allowed)

Wrapper f Columns & Elements ) Custom Templates C ) Sync Templates

iFrame Element Map Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Video Lightbox Block Fea‘:'::e'r"’t'“ge Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttons Block Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Example Title Text

Example Text. Lorem ipsum dolor sit amet, consectetur adif
sed augue imperdiet posuere non non elit. Donec tempus ¢
maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut odio quis, porta lobortis |
onsequat ut ante sed, sagittis venenatis sem. Aenean nor
rna ac dictum efficitur, dui turpis molestie libero, at ultrice

aesent eu tristique arcu, vel facilisis mi.

- A TOGGLE BOX TITLE

A toggle box content area




3. Click the pencil icon to edit the template (orange outline with the Toggle Box t|tIe)

erat. Praesent eu tristique arcu, vel fracilisis mi.

Toggle Box [ & x- BOX TITLE
-

A toggle box content area

i+ A TOGGLE BOX TITLE

4. Click onatabto open it. From there you can edit the Toggle Box Title and Content.

A Toggle Box Title @

Head Text
Title
A Toggle Box Title
=
Content
Q3 Add Media | ‘ @ Caldera Form | [ Insert shortcode Visual | Text
File v Editw View s Insets Formate Tools v Table »

B I U =¥ =+v = GDLR Core v A v

A toggle box content area

—————




5. The Is Active toggle sets which items are open by default. It’s on a per tab basis so be
sure to only have one open.

= M Vv HHT HH O G N

A toggle box content area

Is Active

oN

f

6. To add another tab to the Toggle Box, click the green plus. To remove one, click the
red x.

Add Toggle Box Tab @
A Toggle Box Title l\ -q@

A Toggle Box Title @

B save Options

7. Click Save Options and then click Save Draft.

B Save Options

R

8. If you are finished making changes, you can click Publish and then Submit For Review.




Accordion Element

— AN ACCORDION TITLE

An accordion content area

+ AN ACCORDION TITLE

Description: The Accordion Element is a convenient way to store a collection of information
into a small amount of space. The Accordion Element functions exactly like the Toggle Box
Element, except in that when a user opens one of the items, it closes the rest so that there is
only one item open per Accordion Element.
Resizable: Takes the width of the container.
Compatible Templates:

e Main section of these: Department Page, Program Page, Basic Page, Personnel Bio

Page, Content/Hours Block

e Other: Default Block
Additional Notes: Be careful to be sure you paste content without external formatting (paste
as plain text). There is an issue that could potentially could cause the template to be
unopenable with some formatting (this issue should be resolved now, but there may be edge
cases).

How?

1. Search within the Custom Templates “Accordion Element” (case insensitive and
partial keywords allowed)

Wrapper / Columns &% Elements ) Custom Templates C ) Sync Templates

iFrame Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Accordion Element

ample Title Text

Exgmple Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit.
seq augue imperdiet posuere non non elit. Donec tempus sapien in el
imus. Curabitur ultricies a nibh convallis sodales.

Cu
co

bitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean
eqguat ut ante sed, sagittis venenatis sem. Aenean non neque saj
urn@ ac dictum efficitur, dui turpis molestie libero, at ultrices erat puru

Pradisent eu tristique arcu, vel facilisis mi.

P - AN ACCORDION TITLE

An accordion content area




3. Click the pencil icon to edit the template (orange outline with the Accordion title)

Tl L I UMT T L U LIS UA WS M, VS w1010 1

Accordion . [ & lEx RDION TITLE
-

An accordion content area

i+ AN ACCORDION TITLE

4. Click on a tab to open it. From there you can edit the Accordion Title and Content.

An Accordion Title

®

Head Text

Title

An Accordion Title

[—

Content

©) Add Media | | @ Caldera Form | [1 Insert shortcods

Visual = Text
File v Editw Vieww« Insef« Fomate Tools» Ta

able v
B

=

y

u

: L -

GDLR Core v | A~
EFTEoE-BeRI[N

An accordion content area

e

An Accardinn Titla




5. To add another tab to the accordion, click the green plus. To remove one, click the red
X.

Add Accordion Tab @

An Accordion Title t %@

An Accordion Title @

Initial Artiva Tah

6. There are also optional settings below (Initial Active Tab sets which tab is open, 1
meaning the first one is open, this is the default. Allow Closing All Tabs let’s a user
close all tabs. This is off by default).

Initial Active Tab

Fill the number of the initial active tab, starling with 1. Filling 0 to close all tabs at

1

Allow Closing All Tabs

7. Click Save Options and then click Save Draft.

8. If you are finished making changes, you can click Publish and then Submit For Review.

Tabs Element

What and Why?



title 1 Tab2 Tab3 Tab4 Tab5s

1Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem sed augue imperdiet posuere non non elit. Donec
tempus sapien in erat efficitur maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla, consequat ut ante sed, sagittis venenatis sem.
Aenean non neque sapien. Fusce dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non erat.
Praesent eu tristique arcu, vel facilisis mi.

Description: The Tabs Element provides a convenient method to display a collection of
information without taking large amount of space.
Resizable: Takes the width of the container.
Compatible Templates:

e Main section of these: Department Page, Program Page, Basic Page, Content/Hours

Block

e Other: Default Block
Additional Notes: For the purpose of mobile friendliness, the Dropdown Element, Toggle Box
Element, and Accordion Element are better alternatives.

1. Search within the Custom Templates “Tabs Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements ] Custom Templates C ) Sync Templates

iFrame Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Element Featured Element Featured Block Personnel Card Page Personnel Bio Page

Video Lightbox Block

Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

xample Title Text

ample Text. Lorem ipsum dolor sit amet, consecte
d augue imperdiet posuere non non elit. Donec ti
aximus. Curabitur ultricies a nibh convallis sodale

urabitur lectus nibh, maximus ut odio quis, porta |

nsequat ut ante sed, sagittis venenatis sem. Aen
rna ac dictum efficitur, dui turpis molestie libero, ¢
aesent eu tristique arcu, vel facilisis mi.

title 1 Tab 2 Tab 3 Tab .




3. Click the pencil icon to edit the template (orange outline with the Text Box title)
dCIprUS, urna ac dictum etficitur, dui turpls molestie libero, at ultrices erat purus non

erat. Praesent eu tristique arcu, vel facilisis mi.

TextBox [ X IlX
-—

fab 2 Tab 3 Tab 4 Tab5

4. To edit the tab titles, change the highlighted text (don’t remove the quotation
marks)..

File v Editw Vieww Insert« Formate Tools » Table »

v = ¥

GDLR Core v | AAv

~

B o E-Be 8N

&

(11}
Jill
it 4

[gdlr_core_tabs]

[gdlr_core_tab title="title 1"]

1 Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem sed augue imperdiet posuere non

non elit. Donec tempus sapien in erat efficitur maximus. Curabitur ultricies a nibh convallis sodales.

sagittis venenatis sem. Aenean non neque sapien. Fusce dapibus, urna ac dictum efficitur, dui turpis molestie

libero, at ultrices erat purus non erat. Praesent eu tristique arcu, vel facilisis mi.

[/gdlr_core_tab]

FrAle anwa fakh #1#51a_"Talk A"l

5. To edit the tab content, change the highlighted text.

File v Editw View~ Insert» Formate Tools v Table »

GDLR Core v  AAY

¥ = v

w@
~

s ago@m-EBe RN
[gdlr_core tabs]

[gdlr_core_tab title="title 1"]

1 Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem sed augue imperdiet posuere non
non elit. Donec tempus sapien in erat efficitur maximus. Curabitur ultricies a nibh convallis sodales.

sagittis venenatis sem. Aenean non neque sapien. Fusce dapibus, urna ac dictum efficitur, dui turpis molestie
libero, at ultrices erat purus non erat. Praesent eu tristique arcu, vel facilisis mi.

[/gdlr_core_tab]

Fedle  mmwa $adh #335]a_"Talw 2’




6. To add or remove tabs, select the shown area and delete or copy it (all tabs must be
within the [gdIr_core_tabs] [/gdIr_core_tabs] shortcodes).

File v Editw View v Insert» Formatw Tools v Table »

GDLR Core v  MAY

[gdlr_core_tab title="title 1"]

m—
1 Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem sed augue imperdiet posuere non

non elit. Donec tempus sapien in erat efficitur maximus. Curabitur ultricies a nibh convallis sodales.

sagittis venenatis sem. Aenean non neque sapien. Fusce dapibus, urna ac dietum efficitur, dui turpis molestie

libero, at ultrices erat purus non erat. Praesent eu tristique arcu, vel facilisis mi.

S—

wAlr  anwa Fakh #13lA"Talk A"

7. Click Save Options and then click Save Draft.

B Save Options

R

Save draft Preview m

8. If you are finished making changes, you can click Publish and then Submit For Review.

Contact Element

What and Why?



Contact Text

Primary@email.com

o/ (509) 509-5095

Building 1800

= Room 1800

Description: The Contact Element provides contact information for pages that don’t use the
Contact Block or similar page footer blocks. Generally, these are used for pages that aren’t
exactly standalone departments/programs but are more of separate services that have
different contact information than standard pages.

Resizable: No.

Compatible Pages/Blocks: This can be swapped with the right section of either Basic Page or
Default Block (for this block, you will need to resize the Default Block to 2/3 to fit, see How to
properly resize templates).

Additional Notes: this is not a full width template. This should not be used in combination
with the Back To Page Element or the Hours Element. If either of those are already being
used a page, consider using one of the following footer blocks for providing contact
information: Contact Block, Contact/Links Block, Contact/Staff Block, or Contact/Staff/Links
Block.

To edit the Title, see the Title Element (start on step 3).
To edit the contact information:




1. To edit the contact information, click the pencil icon to edit the template (orange
outline with the Icon List title)

(509) 509-5095

Building 1800

Room 1800

2. To edit an item, click on one of the tabs to open/close the dropdown.

lcon List (+)

Primary@email.com

(509) 509-5095

Building 1800
L ]

Image

lcon




3. To edit the email address, replace the highlighted text with an email address.

lcon

fa fa-envelope

Icon Hover

Content

Primary@email.com

Caption

Link Url
mailto:Primary@email.com

Link Target

Current Screen v

Then copy the email address into the highlighted text, but put mailto: in front to
make it work as a clickable link.

Icon

fa fa-envelope

Icon Hover

Content

Primary{@email.com

Caption

Link Url

mailto: Primary@email.com

Link Target

Current Screen v

4. To edit the phone number, replace the highlighted text with a phone number (in this
format).



https://developers.google.com/style/phone-numbers#:~:text=To%20format%20phone%20numbers%20in,with%20the%20four%2Ddigit%20number.
https://developers.google.com/style/phone-numbers#:~:text=To%20format%20phone%20numbers%20in,with%20the%20four%2Ddigit%20number.

fa fa-phone

Icon Hover

Content

(509) 509-5095

Captien

Link Url

Link Target

Current Screen v

Then copy the phone number into the highlighted text, but put tel: (or sms: for
texting) in front to make it work as a clickable link.

lcon

fa fa-phone

lcon Hover

Content

Caption

Link Url

tel:(509) 509-5095

Link Target

Current Screen v

5. The instructions to edit the other contact information is similar, except linking it
optional. If you don’t need particular information, you can delete an entire tab by




clicking on the x.
Icon List @
Primary@email.com

(509) 5095095

®
®
Building 1800

Room 1800 ®
6. Click Save Options and then click Save Draft.

7. If you are finished making changes, you can click Publish and then Submit For Review.

If you want to add an item back, follow the steps below.
1. Click the green +.

Icon List

Primary@ema.com ®
(509) 509-5095 ®
Building 1600 ®
Room 1800 (x)

2. Add icon text into the highlighted field. It can be one of the following bolded:

For email address: fa fa-envelope
For phone number: fa fa-phone
For building number: fa fa-map-signs




For room number: fa fa-building

Primary(@email.com

Image

Icolt

fa fa-envelope

lcon

Content

rimary@email.com

Caption

3. Proceed to edit the item as shown above starting at step 5.
How to replace a right-side template with the Contact Element:
1. Delete the pre-existing right side template (be sure to delete the yellow highlight,
which indicates the column).

[su_icon icon="icon: arrow-left"
background="transparent”

color="white" size="16" margin="0px
1 dolor sit amet, consectetur adipiscing elit. Praesent ac

Opx Opx Opx" target="self"][/su_icon]

»t posuere non non elit. Donec tempus sapien in erat efficitur Back to moinpggg

2s a nibh convallis sodales.

imus ut odio quis, porta lobortis mi. Aenean purus nulla,
gittis venenatis sem. Aenean non neque sapien. Fusce

L




2. Once removed, search within the Custom Templates “Contact Element” (case
insensitive and partial keywords allowed)

Wrapper / Columns & Elements ) Custom Templates () syncTemplates

iFrame Element Map Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block

Example Title Text Contact Text

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac [su_icon icon="icon: envelope-o”
lorem sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur background="transparent”
maximus. Curabitur ultricies a nibh convallis sodales. color="white" size="16" margin="0px

0Opx Opx 0px’][/su_icon]

Curabitur lectus nibh maximus ut odio anis norta lobortis mi Aenean nuris nuolla

4. Proceed to follow the previous instructions on how to edit the contact information
(To edit the contact information).

Back To Page Element

What and Why?

Description: The Back To Page element let’s you place a link pointing back to a previous page,
presuming the current page is related some other ‘main’ page. It's common for this to be
used on FAQ pages or other pages providing additional pages related to a program or
department.

Resizable: No.




Compatible Pages/Blocks: This can be swapped with the right section of either Basic Page,
Default Block (for this block, you will need to resize the Default Block to 2/3 to fit, see How to
properly resize templates).

Additional Notes: this is not a full width template. This should not be used in combination
with the Contact Element or the Hours Element. If either of those are already being used a
page, consider using one of the following footer blocks for providing contact information:
Contact Block, Contact/Links Block, Contact/Staff Block, or Contact/Staff/Links Block.

To edit the link this goes to:
1. To edit the link, click the pencil icon to edit the template (orange outline with the Icon
List title)
T3 Z & X x

Yoast SEO

2. Open the item by clicking on it

Icon List <+>
Back to mainpage @
S

Image




3. Paste the new link in the Link Url section

\.rl'.vll.l'LIUII

Link Url

hitps:/fdev bigbend edw/academics/a rt.-]

Link Target

Current Screen

4. Click Save Options and then click Save Draft.

5. If you are finished making changes, you can click Publish and then Submit For Review.
To add an template that uses the Back To Page template, go here.

Alert Box Element
What and Why?

A womce

Alert box itern sample content

Description: The Alert Box lets you place a notice on a page. This is useful for placing
temporary important information concerning services, Covid-19, etc.
Resizable: Takes the width of the container.
Compatible Templates:
e Main section of these: Department Page, Program Page, Basic Page, Content/Hours
Block
e Other: Default Block




Additional Notes: Avoid using this element more than once per page. Also limit how much
information you put in there, preferably up to one paragraph.

Excessive use of Alert Box Element makes the page cluttered and overwhelming. Be sure to
prioritize what’s important on your page.

How?

1. Search within the Custom Templates “Alert Box Element” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements

] Custom Templates () syncTemplates

iFrame Element

Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Video Lightbox Block Fertins) o

Element Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block

Program Page Department Page
2. Dragthe template from the Custom Templates list and then drop it into a compatible
template.

Alert Box Element




3. Click the pencil icon to edit the template (orange outline with the Text Box title)
T3 & X x

Alert Box E.i. I x

NO

Alert box itemn sample content

Example Title Text

4. You can select a new icon (leave the icon type as Font Awesome 5), change the title,
and change the primary content.

lcon

Font Awesome 5 v

Search lcons

(-] E
= a0
© € |3
(%) “ 7
= AN
(E B ¥

Notice

————

Content

Q) Add Media | | @ Caldera Form | [ Insert shortcode visual || Text

File w Edit» \iew » Insert» Formate Tools » Table «

GDLR Core v+  AA~Y

@
~

*

U
S EooE-BES RN

L4

(4
1}

Alert box item sample content
S




5. Click Save Options and then click Save Draft.

6. If you are finished making changes, you can click Publish and then Submit For Review.

In the situation that you place the Alert Box into a template with a light gray background,
the text will look black, like so.

Example Title Text

To fix this, follow these steps.




1. Click the edit icon.
T3 E X x

Alert Box K.'!,'. I x

NO

Alert box item sample content

Example Title Text

2. Click on Style and then slide the Removable (Close Button) to red.

Denera Style Color

Text Align

1




3. Then click on Color and then change Icon Color, Title Color, and Content Color to
white.

Genera Style Color

L
[}
(a8
(]

lcon Color

Select Color

Title Color

Select Color

Content Color

Select Color

"‘g’ BB EES

ground Color

- Select Color




4. Click Save Options and then click Save Draft.

Map Element

What and Why?

Big Bend Community College 7

HE BASE

Description: The Map Element lets you load a location with Google Maps within a website.
Not frequently used, but it can be used to show locations for events. For example, it’s being
used on the Contact Us page.
Resizable: Takes the width of the container.
Compatible Templates:

e Main section of these: Department Page, Program Page, Basic Page, Content/Hours

Block

e Other: Default Block
Additional Notes: The Map Element is made using the Text Box template hence why the title
is labeled as such. The Text Box has a map shortcode within it.

How?



https://www.bigbend.edu/about-us/contact-us/

1. Search within the Custom Templates “Map Element” (case insensitive and partial

keywords allowed)

Wrapper / Columns <& Elements

iFrame Element Map Element

White Divider Element Dnader Element

Featured Image

Video Lightbox Block Element

Hours Element

] Custom Templates

Alert Box Element

Space Element

Featured Element

Content/Hours Block

() Sync Templates

Back To Page Element Contact Element

Text Box Element Title Element

Featured Block Personnel Card Page

Links Block

Tabs Element

Default Block

Personnel Bio Page




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Example Title Text

ample Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit
d augue imperdiet posuere non non elit. Donec tempus sapien in e
aximus. Curabitur ultricies a nibh convallis sodales.

rabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenear
cpnsequat ut ante sed, sagittis venenatis sem. Aenean non neque sa
uina ac dictum efficitur, dui turpis molestie libero, at ultrices erat purt

Ploesent eu tristique arcu, vel facilisis mi.

[su_gmap width="1600" height="300" address="Big Bend Community

3. Click the pencil icon to edit the template (orange outline with the Text Box title)

B L% 600" height="300

-

e e a b P

4. Enter the address in the address section in between the quotation marks. You can
also adjust the zoom, width, and height values, but it’s best to leave them as is in




most cases.

[su_gmap width="1600" height="300" address="g {ER@ELTT = SN M GRS B CRVENE R EY " zoom="15"]

5. Click Save Options and then click Save Draft.

6. If you are finished making changes, you can click Publish and then Submit For Review.

iFrame Element

What and Why?

Description: The iFrame Element lets you load a different webpage within the current one.
This is used rarely, but it’s useful in loading custom html files within the website (the FinAid
Net Price Calculator).
Resizable: Takes the width of the container.
Compatible Templates:

e Main section of these: Department Page, Program Page, Basic Page, Content/Hours

Block

e Other: Default Block
Additional Notes: Some sites have settings that don’t allow you to open a webpage with an
iframe.
The iFrame is made using the Text Box template hence why the title is labeled as such.



https://www.bigbend.edu/student-center/net-price-calculator/

How?

1. Search within the Custom Templates “iFrame Element” (case insensitive and partial
keywords allowed)

Wrapper f Columns & Elements ) Custom Templates C ) Sync Templates

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Buttons Block Content/Hours Block Links Block

Program Page Department Page
2. Dragthe template from the Custom Templates list and then drop it into a compatible
template.

iFrame Element




3. Click the pencil icon to edit the template (orange outline with the Text Box title)

TextBox @ X IEX
-_—

4. Click on the iFrame and then click the video film icon.
Flie w CaIl w VIEW w IN=ciL w FONdl - 10015 w dUIE w

™
ey

u ¥y = v

W BB R

—2

GDLR Core v AA~

é__‘._

14
1]
1]




5. Edit the links as needed. If linking to a page or custom html file within the site, you
can use dev.bigbend.edu as the domain vs www.bigbend.edu. Then click OK

Insert/edit media x

General Embed Advanced

Source https:/fwww.google.com/

Dimensions 480 X | 480 + Constrain proportions

r ]

6. Click Save Options and then click Save Draft.

7. If you are finished making changes, you can click Publish and then Submit For Review.

Program Info Block
What and Why?

Program Outcomes Career Possibilities Transfer Options Industry C

ips & Grants

1. Lorem ipsum dolor sit amet
2. consectetur adipiscing elit
3. Praesent ac lorem sed augue
4.imperdiet posuere non non elit

el o

Description: The Program Info Block provides additional information for the Program Page.
This includes the program outcomes, career possibilities, transfer options, industry
connections, and scholarships & grants.

Resizable: No.

Compatible Pages: Program Page

Additional Notes: This is a full screen width template.




How?

1. To edit the tabs, click the pencil icon to edit the template (orange outline with the Tab
title)
.

T Z I & x X

Tab # X 1lx
-

2. To edit an item, click on one of the tabs to open it.
A0 New 1abD {\1—)

F‘rcrﬁram Outcomes

Career Possibilities

Transfer Options

Industry Connections

Scholarships & Grants




3. For the Program Outcomes tab, you can list the program outcomes. In some cases,
these can be pulled from the course catalog.

Title

Program Qutcomes

Content

i Insert shortcod
) Add Media | | @_Caldera Form | [ Insert shortcode

B I U =+ =+ [] GDLR Core v  AA v

S W ¢ Hr & R DE

(£ J]
"

1. Lorem ipsum dolor sit amet

2. consectetur adipiscing elit

3. Praesent ac lorem sed augue

4. imperdiet posuere non non elit

4. For the Career Possibilities tab, you can list possible jobs students can expect after
program completion. Be sure to leave the bottom line (highlighted text).
Title

Career Possibilities

Content

03 Add Media ] l @ Caldera Form l [] Insert shortcode

T u =~ =+ [] GDLR Core v A

T
il
B
<
i
4
)
%3
=

* Lorem ipsum dolor sit amet
» consectetur adipiscing elit

* Praesent ac lorem sed augue
+ imperdiet posuere non non elit

For job shadows, tours, and internships, check out the Career Services.




For the Transfer Options tab, you can list transfer articulations and advising maps for
students to continue their education beyond the program. Some relevant transfer
resources, like course equivalencies, can also be added. Noting courses that are used
in other BBCC programs or Areas of Interest would not go here.

Title

Transfer Options

Content

03 Add Media ] [g:- Caldera Form ] [ Insert shortcode

B I U =~ =+ [] GDLR Core v | AAw

3 Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem sed augue
non non elit. Donec tempus sapien in erat efficitur maximus. Curabitur ultricies a nibk

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla, co
sed, sagittiz venenatis sem. Aenean non neque sapien. Fusce dapibus, urna ac dictum ¢
maolestie libero, at ultrices erat purus non erat. Prassent eu tristique arcu, vel facilisis r




6. For the Industry Connections tab, you can list partnerships/connections with
businesses and industries.

Title

Industry Connections

Content

q: Add Media | | @ Caldera Form | [] Inser shortcode

B I U =+~ =+ [] GDLR Core v  MAw
£ T o B 2 REDE

3 Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac loremr
non non elit. Donec tempus sapien in erat efficitur maximus. Curabitur ultr:

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean pun
sed, sagittis venenatis sem. Aenean non neque sapien. Fusce dapibus, urna
molestie libero, at ultrices erat purus non erat. Praesent eu tristique arcu, ve




7. For the Scholarships & Grants tab, you can list program related funding beyond what
the default (leave the highlighted text) covers.

Title

Scholarships & Grants

Content

05 Add Media | ‘ @ Caldera Form ‘ [] Insert shortcode

B I U =¥ =« [:] GDLR Core v MM

=T FEoE PR

3 Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lo
non non elit. Donec tempus sapien in erat efficitur maximus. Curabitur-

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean |
sed, sagittis venenatis sem. Aenean non neque sapien. Fusce dapibus, w
molestie libero, at ultrices erat purus non erat. Praesent eu tristique arc

» BBCC Scholarships
* Workforce Education Services
* SkillSource

8. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m

9. If you are finished making changes, you can click Publish and then Submit For Review.




Degrees & Certs Block

What and Why?

Degrees & Certificates

DEGREE NAME
CERTIFICATE NAME

Description: The Degrees & Certs Block provides a simplified view of the degree and/or
certificate information found in the degree maps.
Resizable: No.

Compatible Pages: Program Page
Additional Notes: This is a full screen width template.

How?

1. To edit an item, click the pencil icon to edit the template (orange outline with the
Toggle Box title)

Wrapper = s X 2 %
11 Z b & x

Degrees & Certificates

Toggle Box [ X 1WxX AME
L

+ CERTIFICATE NAM




2. From here, you can enter the degree/certificate name in the Tile field.

Title

Degree Name

Content

0 Add Media | | @ Caldera Form | [] Insert shortcode

B I U =v =~ [] GDLR Core v

Total Credits: go
Learning Outcomes:

* Dutcome 1
* DOutcome 2

Then you can enter the number of credits in the degree/certificate next to the Total
Credits text (it can be a range).

J

™
~

u =v =v []

B 0 B & R b

i
0]}

F 1

Total Credits: go
Learning Outcomes:

* Outcome 1
* QOutcome 2
* Qutcome 3

Next you can add the learning outcomes for that degree/certificate. In some cases,




this can be the same as the program outcomes.

W
~

u =v =v []

B 0 B & R b

i
0]}

F 1

Total Credits: go
Learning Outcomes:

* (Outcome 1
* QOutcome 2
* QOutcome 3

Next you can enter the courses/credits into the respective year/quarters (this is based
off the information found in the advising maps).
[su_table responsive="yes"]

Course Credits
ENGL& 101 g

If you need another row for a course, click within the table on the last row, click on
the table menu->hover over row->click ‘Insert row after’. Similarly you can delete a
row by clicking ‘Delete row’.




l - i ] l" dla=Td T U1 ]

B I u =~ =+~ I[]®
= S @ Ha P R D
EH Table

[=dlr core

Table properties

ore_tab ti
Delete table
[su_table respons
Cell

ENGLE& 101
Column

L =

[/su_table]

GDLR Core v  AA

k

Insert row before

]
b Insert row after

Delete row

Table row properties

Cut table row

Copy table row

If you need to add another quarter (for example, one for summer), copy the shown

text and paste before the closing shortcode.

* Qutcome 2
* QOutcome 3

Year1

gdlr_core_tabs

) Bl=dir_core_tab tifle—"Fall"]

[su_table responsive="yes"]

[/su_table]

[

gdlr_core_tab title="Winter"]
su_table responsive="yes"]

Course

Credits




[/su_table]

[/edlr core_tab] ‘

[/edlr core_ tabs]

Year 2

[gdlr core tabs]

[zdlr_core_tab title="Fall"]

If you need another year, copy the shown text and paste it after the closing
shortcode. Certificates may not have multiple years, in that case you can delete the




shown text.

gdlr core_tabs]
gdlr_core_tab title="Fall"]

su_table responsive="yes"]

/su_tah

i i i i i E
I,_.

Jedlr_core_tah]

gdlr_core_tab title="Winter"]

su_table responsive="yes"]

Jgdlr_core_tab]

gdlr_core_tab tifle="Spring"]

su_table responsive="yes"]

/su_table]

Jgdlr_core_tab]

— — -
P STRONG




4. Click Save Options and then click Save Draft.

L1
=%}
=

5. If you are finished making changes, you can click Publish and then Submit For Review.

Program News Block
What and Why?

Program News

Description: The Program News Block provides a section to links to news articles or BBCC

posts related to the program.
Resizable: Block: no. Sections/columns: yes. Can be five 1/5 columns, four 1/4 columns, three

1/3 columns, two 1/3 columns, one 1/3 column. See how to properly resize templates.

Compatible Pages: Program Page
Additional Notes: This is a full screen width template. If there are more than five articles, use

the ‘See more articles’ to link to a separate page with more links or to the post category for
BBCC posts.

How?

1. To edit the item image, click the pencil icon to edit the template (orange outline with
the Image title)




Program News

Evearanmla Aviiala CvraranlAa
Next click the minus icon and then the plus to change the existing image. (If adding a

new image, follow the Media upload and accessibility instructions.)

Upload Image

N
Thumbnail Size

2. To edit the item title, click the pencil icon to edit the template (orange outline with
the Text Box title)




Text Box FLiEix €
-

Name

From here you can just change the text highlighted.

07 Add Media | | @ Caldera Form | [1 Insert shortcode

o

E I u EE A E b 1 Gl

Example Article Name

3. To edit the item link, click the pencil icon to edit the template (orange outline with
the Button title)

Example Article Examg

Name

Name

Button 2 Ex
u




Next you can enter the article link in the Button Link field.

Button Text

Read More

Button Link To

Custom Url w

Button Link

Button Link Target

New Window A

lcon Position

1 nft

4. To edit the ‘See more articles’ link, click the pencil icon to edit the template (orange
outline with the Text Box title)

TextBox [ X IlX
-




Click on the text and click on the pencil icon that appears.

L J o\

See malre articles

# o 1
L

Replace the # to your new link and click the return icon.

J L J

Iy =+ =+ » GDLR Core v @
= @ 0 B[P R BB

i
]

See more articles

https://dev.bigbend.edu/academics/art/ I ﬂﬁ

5. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m

6. If you are finished making changes, you can click Publish and then Submit For Review.




Other
Big Bend Brand

Colors and fonts

The website colors
BBCC Green:
e Hexvalue: #30763a
e RGB value: rgh(48, 118, 58)
BBCC Blue:
e Hexvalue: #132048
e RGB value: rgh(19, 32, 72)
White:
e Hex value: #ffffff
e RGB value: rgb(255, 255, 255)
e HTML color value: white
Light Gray:
e Hex value: #f5f5f5
e RGB value: rgh(245, 245, 245)

The BBCC fonts
Logo font 1: Times New Roman (or similar)
Logo font 2: Arial (or similar, Helvetica)

Website font: Poppins, sans-serif

Page Builder Information

What and Why?

If you do not see the Page Builder, click on the Page Builder section to open it:
Type / to choose a bloc

Page Builder v oov
Yoast SEO ANV oa

SEO Readability | $8§ Schema | «§ Socia

Google preview ~

Preview as:

@) Mnhiln el

Below is an image of the page builder with numbers corresponding with the numbered list
below it.




Page Builder

Wrapper / Columns. & FElements @) Custom Templates () SyncTemplates

X save Template

1. Wrapper/Columns button: when clicked, this shows the theme templates for
wrappers and columns (for page structure). This should only be used by web
developers as these are not sized correctly for design consistency. A good starting
point for custom templates would be the Default Block under Custom Templates.

2. Elements button: when clicked, this shows the page templates for content. This
should only be used by web developers as these are not sized, colored, nor font-sized
for design consistency. Check out the Custom Templates button as those are designed
for consistency and accessibility.

3. Custom Templates button: when clicked, this shows the templates that have been
designed to be design consistent and accessible. It is highly recommended you use
these for pages and follow the instructions for how to use each.

4. Sync Templates button: when clicked, this shows all of the saved synced templates.
Synced templates are synced across the entire website (editing one on a page would
change it elsewhere the template is used). Not currently used, but it should only be
used by a web developer, site admin, or web manager.

5. Expand button: This button expands the page builder. This is sometimes useful in
resetting it when it bugs out or gets stuck (it’s supposed to follow your view as you
scroll in the page content).

6. Reset button: The reset button clears the page content, useful when tinkering with a
new page and wanting to restart.

7. Save Template button: When pressed, it will save the page content into a Custom
Template. If your page is too large, it may fail as there is a maximum template size.
This should only be used by site admins or web managers. It can be useful for
transferring templates across several pages (be sure to delete no longer needed
templates), though it may be better to use the Copy Draft functionality instead.

8. Block Mode button: using this renders the page content without styling (text content
will not show). This can be useful when a page has a lot of content, if there is poor
connection, or when your computer runs sluggishly as it runs lighter.

9. Preview Mode button: much like the Block Mode button, this renders the page
without styling, but it does include some text content (shortcodes will not show). This
is useful to view the content how it’ll look when live, though it may not be a bit
squished correctly due to the other backend sections on the right and left of the page
builder.

10. Live Mode button: using this renders the page content with styling and with text
content (including shortcodes, though only text form).




11. Edit button: only active during Live Mode, this shows the page content with the
wrappers and columns.

12. Preview button: only active during Live Mode, this shows the page content without
the wrappers and columns.

13. Undo & Redo button: clicking these will undo and redo actions made within the page
builder. Editing the page title, for example, will not be undone/redone clicking these.

On all of the templates, there are 4-5 buttons.

1234
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1. Edit button: This opens the interface to edit the highlighted template. Wrappers (blue
outline) and columns (yellow) should generally be left alone unless you are a web
developer.

2. Save Template button: This saves the highlighted template into Custom Templates.
This should only be done by site admins or web managers.

3. Copy button: This duplicates the highlighted template. This can be useful, for
example, to duplicate an existing Title Element or Text Element.

4. Delete button: This deletes the highlighted template. If unintentionally clicked, you
can click the undo button in the page builder.

5. The last button that shows up only on wrappers is the Save Sync Template button.
Clicking this saves the wrapper and it’s content into the Sync Templates section and
should only be used by site admins or web managers.
|
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How to use shortcodes

What and why?

In WordPress, shortcodes are a step above custom coding. They provide additional
functionality with relatively basic implementation. That said, mistakes still can be made as it’s
not as simple as a visual builder. Below are the instructions in ensuring you use the
shortcodes correctly.

Note: the overall usage is slowly reducing as the website is updated with more visual builder
templates. You will still likely run into these, so it’s useful to know how to use them. If
possible, replace them with an updated template from Custom Templates. The list below is
sorted in frequency of usage.




How?

All shortcodes follow a similar structure. There is the opening tag ([shortcode_name]) which
contains attributes. The attributes (after the shortcode name and before the right bracket of
the opening tag) usually have the attribute name followed by an equals sign followed by the
attribute value in double quotation marks (attribute="value”). The last piece to the
shortcode is the closing tag ([/shortcode_name]).

For some shortcodes, there is can be content place between the right bracket of the opening
tag and the left bracket of the closing tag ([shortcode_name]content[/shortcode]).

Lastly, there are shortcodes that are made up of multiple shortcodes together. There is the
opening tag of the parent shortcode, a collection of full child shortcodes as the content of the
parent shortcode, and then the closing tag of the parent shortcode

Note: you always want to make sure that the attribute values are always surrounded by
double quotes. If you are adding a Title value, use single quotes as part of the title so that it
won’t close out the value sooner than needed. Bad example, title="The “Real” Slim Shady”.
Good example, title="The ‘Real’ Slim Shady”.

Icon:
® Shortcode: [su_icon icon="icon: building-o" background="transparent"
color="white" size="16" margin="0px Opx Opx Opx" target="self”][/su_icon]
® Name: su_icon

® Attributes:

o icon: This sets the free icons available from Font-Awesome with the format
being “icon: icon-name”.

o background: This sets the background color for the icon with any HTML color
value (HEX, RGB, HTML color name). It’s recommended that you leave it as
“transparent” so that it takes the background color of it’s container.

o color: This sets the color for the icon with any HTML color value (HEX, RGB,
HTML color name). It’s recommended that you leave it as is, but in the
situation that you need to change it, you can use these options. On a dark
background (BBCC blue, BBCC green), set it to “white”. On a lighter
background (white or light gray), set it to “black”.

o size: This sets the font size of the icon in pixel values. Leave as is, but in the
situation that it’s been changed, the default is 16.

o margin: This sets the margin value around the font in a set of 4 pixel values in
the format of “Opx Opx Opx Opx”. It goes in order of top, right, bottom, left.
Leave as is.

o target: Because the icon shortcodes run like links (not a desirable functionality,
but that’s just the way they are), setting the target to “self” prevents it from
opening a new tab.
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® Content: None. If you need to place a link or text with the icon, put it on the same line
as the shortcode after the closing tag.
Dropdown/Spoiler:
e Shortcode: [su_spoiler title="Dropdown Title"]Dropdown Content[/su_spoiler]
e Name: su_spoiler
e Attributes:

o title: This sets the text that the user can click on to show the Content of the
shortcode. This can be any string value, but it’s important to limit how much
text you add (remember, on mobile there is less screen space). Also do not
add an additional double quote (“) as that can break the shortcode. Use single
quotes (‘) if needed.

e Content: There can be content placed after the open tag and before the closing tagin
between the brackets. This is what will show up when the dropdown/spoiler is clicked
on.

e Shortcode: [gdIr_core_tabs][gdIr_core_tab title="title 1"]
[/gdIr_core_tab][/gdIr_core_tabs]

e Name: gdir_core_tabs, gdIr_core_tab

e Attributes:

o Child title: Because the Tabs shortcode is made up of smaller shortcodes
bundled, the parent shortcode (gdlr_core_tabs) does not have any attributes,
its only purpose is to contain multiple child shortcodes (gdlr_core_tab). The
child shortcode has a title value, which sets the text the user can click on to
show the Content of the child shortcode. This can be any string value, but it’s
important to limit how much text you add (remember, on mobile there is less
screen space). Also do not add an additional double quote (“) as that can break
the shortcode. Use single quotes (‘) if needed.

e Content:

o Parent shortcode: The parent shortcode’s content is a collection of child
shortcodes. There can be multiple child shortcodes as long as the parent
shortcode has it’s opening tag at the beginning and the closing tag at the end
of the collection. Each child shortcode must also have it’s proper opening and
closing tag with it’s content.

o Child shortcode: the child shortcode’s content is placed after it’s opening tag
and before it’s closing tag in between the brackets.

e Shortcode: [su_gmap width="1600" height="300" address="Big Bend Community
College" zoom="15"]
e Name: su_gmap
e Attributes:
o width: This sets the map width in pixel values. It will resize to fit the container.
o height: This sets the map height in pixel values. It will resize to fir the
container.




o address: This sets the location to show depending on the street address. It can
be helpful to find the location on Google Maps and pull the street address
shown there. Also do not add an additional double quote (“) as that can break
the shortcode. Use single quotes (‘) if needed.

o zoom: This sets the zoom level at which the map shows the location. A larger
number is closer, a smaller number is farther away (0 is the lowest and 15 is a
good default).

e Content: None.

How to modify background sync heights

What and why?

Some templates make use of a setting that links the height of them with others with the
same setting (the tallest setting the height for the rest). You'll see this with templates like
Contact/Staff Block, Contact/Staff/Links Block, Contact/Links Block, and more where the
content in some sections is more than others, but they all have the same height. This should
rarely (especially for footer blocks) be changed as they make the pages look more visually
appealing. Having sections that need to look like a solid block looking chunky is no good.
Some templates (like Buttons Block, Featured Element, or Featured Image Element) may
need to be set independent or split into different groups of each other if there are many of
them. Here is how to modify the setting.

1. ldentify whether it’s necessary. In most cases it’s not worth changing it as the
consistent sizes is nice. In the rare situation that it is needed, you can change it. In this
example image, you can see that the high level of content (exaggerated for example,
please don’t add that much content into a Featured Element, use a Featured Block
instead.) in the top row is making the bottom row very tall. We can make the bottom
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or top row sync to different settings.
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2. We are going to edit the bottom row in this example. Click the edit button of the
Featured Element (orange highlight). For some tempaltes, you need to edit the

column (yellow highlight).
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Go to Background Style and edit the Sync Height value. All of the Featured Elements
with this value will sync heights. In this example I'll change it to boxes-2 for the

bottom row and leave it as boxes-1 for the top row. In some cases, you can remove
the value altogether, but that can lead to unexpected behavior.

Background Style

Sync Height

Use to sync the height among an items with the same keyword. The height will
boxes-1

——

be fixed so be caufious not to use it on item with dynamic height

Positioning Content In The Middle Of This ltem ( When sync hieght is being used )

ON

Background Image

The instructions are similar for editing column (yellow highlight) background heights
(which is sometimes used when an element doesn’t have that feature directly). Go to




Background and edit the Sync Height. Any other columns with that value will sync
heights.

&3 ITEM OPTIONS
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Full Height Wrapper

Effects will only be shown at thi

OFF
Sync Height
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4. Be sure to click Save Options and repeat for all of the templates needed.

B save Options
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5. Now we can see that the two rows are syncing with their respective groups.
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Note: One of the additional reasons that changing this is discouraged is that it will affect how
these will look on mobile. Most users don’t consider how their page looks on mobile. Also if
you are running into the issue, it’s likely an issue of excessive content (too many words in the
wrong template, too many of the same template, robust/wordy language, etc.) which should
be addressed first.

How to properly resize templates
If you look at the templates in the Custom Template Guide, you will see that some of them
have a Resizable attribute. This indicates whether the template, or sections of it, have been
designed to be resized. Technically all of the templates, if placed in columns, can be resized
any size 1/6, 1/5,1/4, 1/3, 1/2, 2/3, or 1/1. The issue is that not all sizes look good in terms of
design and usability (and consistency too), which is why the guide details different size
formats. In a few places you will see that these rules are not followed exactly, but the
exceptions are few and it seems to be seriously considered before modifying them outside
the recommended settings.

To modify the templates, isn’t too difficult. Just be sure to follow the recommended settings.
For this example we’ll use the Buttons Block.

1. Identify the template used. Most of the modifiable templates are not entire page
templates, but usually small content templates. For example, if you see a template
that uses a 2/3 and 1/3 template, you are likely looking at a page template or footer
template. Do not modify the sizes, but instead replace it with a different template. If
it’s something like four 1/4 templates or three 1/3 templates, that is a collection of
small content templates. These are usually one of the following templates: Featured
Image Element, Featured Element, Featured Block, Card Element, Buttons Block.




2. See the Resizable attribute parameters. If for example you only need three buttons in
your Buttons Block, you can delete one and resize them to 1/3.
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3. The reverse can be also be done. If you need four buttons, you can resize them to 1/4
and the duplicate one.
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4. Remember to follow the noted settings with each template in the guide. Doing so
incorrectly can lead to squished content, empty spaces, unpleasing design, or other
unexpected behaviors. Click Save Draft when finished resizing.

Note: if you need two rows of buttons or similar templates like Featured Elements, you
should duplicate the columns (yellow highlight) and not the template itself (orange highlight).

How to properly swap blocks/elements
Even though the visual page builder does make it easier to organize content, there are some
situations that can make it finicky as well as there being a proper way to do so.
How?
Compatible templates. (example: basic page blue sections, footer template swapping).

The first thing you need to ensure is that you are swapping templates with compatible
counterparts. All of the templates within the Custom Template Guide show compatible
templates, where possible. In the examples below it will show how to swap templates within
a block (using the Basic Page template) and then swapping out entire block templates (using
two footer blocks).

1. Given a page that uses the Basic Page template, by default it includes the Back To
Page template as the 1/3 section. In most cases we can leave it as is, but there are
situations where we’d want to swap it with a swappable template (Back To Page
Element, Hours Element, or Contact Element). We'll start out by removing the default




template (yellow highlight).
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Example Title Text [su_icon icon="icon: arrow-left"
background="transparent”
color="white" size="16" margin="0px

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac

lorem sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur

0Opx Opx Opx” target="self"][/su_icon]

Back to mainpage
maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla,
consequat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce
dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non
erat. Praesent eu tristique arcu, vel facilisis mi.

Next we will search and drop in the Hours Element. You can then drag it next to the
gray 2/3 section where the previous template was.

Example Title Text Mon-Thurs 07:30-4:30 O

Friday 07:30-3:30 ©
Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac

Sat-Sun Closed ®

lorem sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur
maximus. Curabitur ultricies a nibh convallis sodales.

Click Save Draft to save progreSS.
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Given a page that uses the Contact/Links Block template (or another footer template),
if we want to add or remove another section, like staff/faculty information, we’d need
to replace the entire block template. Here we’ll start by dragging in the replacement




2.

Program/Department Contact Program/Department Faculty/Staft Additional Links

Mo parsonnel found, pleose crects the personnel post to use

In some cases we are able to drag and drop the content of a section into the new
replacement template. Here we’ll drag in the title and textbox from the old template
contact section and delete the default title and textbox in the new replacement.
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Unfortunately you can’t move white text into white backgrounds, so some sections
you’ll have to open and copy paste the text and links into the new templates (at lease
for now).




3. Once you have transferred all of the content into the new template, you can delete
the old block template (blue outline).

[su_icon icon="icon:
map-signs”
background="transparen
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Additional Links

[su_icon icon="icon: link" background="transparent’ color="%
size="16" margin="0px Opx Opx Opx" target="self"][ [su_icor

su_icon icon="icon: file-pdf-o" background="transparent” coloi
size="16" margin="0px Opx Opx Opx" target="self'][/su_icor

The visual page builder follows a structure of wrappers containing columns containing
elements. When you are dragging an item, usually you want it to go into the same type of
container that it came in. For example, if dragging a column (yellow highlight), like with the
example with the Basic Page and Hours Element, you want it to be placed in a wrapper (blue
highlight) since that’s the container the previous template was in. When dragging the
textboxes (orange highlight) in the example with the footer templates, you want it to be
placed in a column (yellow highlight) since that’s what it was in the replaced template. A
good rule of thumb is that elements (orange highlight) always go in columns (yellow
highlight) and columns always go in wrappers (blue highlight).

Sometimes you may experience unexpected behavior when dragging templates to swap or
just in moving them. Below are some tips in getting better results.




e Watch for a little triangle that points to where the template will be placed relative to
the container.

Example Title Text

Example Text. LIS ipsum dolor sit amet, consectetur adipiscing elit. Praese
sed augue imperdiet posuere non non elit. Donec tempus sapien in erat effic
maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus
consequat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fu
urna ac dictumn efficitur, dui turpis molestie libero, at ultrices erat purus non ¢
Praesent eu tristique arcu, vel facilisis mi.

e Sometimes when using a lower performance or smaller screen device, it may be
helpful to use a different rendering mode (see items 8-10 in the Page Builder
Information). These modes may decrease lagginess or may reduce the content shown
to fit better in smaller screens. Be sure to switch back once in a while to make sure
you’re moving the right content though.

e Sometimes when using a lower performance devices, dragging a large item while
scrolling doesn’t work. In cases like that, you can zoom out in the page builder (by
pressing CTRL + Minus Key on your keyboard) so that you can drag the item without
scrolling anywhere. Just be sure to zoom back in (by pressing CTRL + Plus Key on your
keyboard) when you’re done so that you can see how the page would look more
normally.

e Last but not least, mistakes sometimes just happen which is why you can rely on the
good old undo button (see item 13 in the Page Builder Information).

Setting the parent page

When setting up a new page you need to set a parent page. This is for site structure
purposes. The setup on the website is that all pages fall under one of the following pages; |
Am, Academics, Student Center, and About Us. These pages correlate to the menu structure.
In the old website, pages would be linked several levels down, leading in very long links and




increased difficulty in setting/changing the parent page. On the new website it’s been
simplified.

How?
1. After setting your page title, you can go to the right hand side and find Page
Attributes. This houses the parent page information and is closed by default.

Featured image "
Discussion o
Page Attributes o
Motification Bar .

Select Motification Bar {optional):
Enter Motification Bar Title

2. Once opened, clicking on the Parent Page field will open a list of pages (note: there is
search functionality here, but it is currently not working). Scroll through and select on
of the options: | Am, Academics, Student Center, or About Us. These options won’t
have an indent which should make it slightly easier.

Discussion w

Page Attributes "

Parent Page:

X

Library N

— Purchasing

— Contact Us

— Board Budget -

Order 0

3. Selecting the correct parent page depends on where this new or current page will live
on the website. Often pages are related to other pages. For example, all program
pages have Academics as their parent page, so any new pages connected to a




program would also have Academics as the parent page. If you’re adding a new page
related to student club information, that’d go under Student Center as that’s where
ASB is located along with other student activity pages. Some pages are listed in two
locations, in that case you’d need to choose the more relevant location and select a
parent page based off that.

Known issues

What?
The new website has a list of it’s own issues, though not as many as before. We work to avoid
letting the issues reach the users and page editors, but some are unavoidable or are caused

by user error. Most are noted throughout the documentation where relevant, the rest are
listed below.

Everything looks flattened/squished

Example:

L it L. o

Explore by Area of Interest

[/su_column][/su_row

[su_divider top="no" divider_color="#000000" size="2" margin="20"]

[/su_spoiler]

Yoast SEO

SEO | @ Readability | H% Schema | «§ Social

Google preview ~

Preview as:

Cause:




This is a minor rendering issue that sometimes happens on larger pages or slower
connections. The actual content is unaffected.

Solution:
Click anywhere in the page builder.

Content is missing on the frontend/preview but shows up in the page builder
Example:

- Dropdown Title

Dropdown Content

[su_spoiler]

Cause:
In the example shown, the dropdown is showing empty content (the empty space right
below). The cause is that the shortcode wasn’t closed properly.

—
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[su_spoiler title="Dropdown Title"]

Dropdown Content

/su_spoiler]

Placing the left bracket back in should resolve the issue.




File » Edit« WView » Insert» Format« Tool

[su_spoiler title="Dropdown Title"]

Dropdown Content

[L"su spoiler]

Solution:

Be sure to open/close shortcodes correctly.
Refer to How to use shortcodes.

Content looks funky on the frontend/preview/backend
Example:
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sanibhconvallis sodales. Curabitur lectusnib

h, maximusutodioquis, portalobortismi. Aenean
purusnulla, consequatutantesed, sagittisvene
natis sem. Aeneannonneque sapien. Fuscedapibu

s,urnaacdictumefficitur, dui turpismolestiel
ibero, atultriceseratpurusnonerat. Praesent e
utristiquearcu, vel facilisismi.

Cause:

The example above shows text that looks a bit off, but it can range from text being a different
font, size, text alignment, colors, or more. This is a symptom of external formatting.
Measures have been taken to reduce the changes of this occurring, but sometimes it does
regardless. The best solution to ensure that this does not occur is to write content within the
page builder itself as that will eliminate the source of the issue. If you have to write content
elsewhere, be sure to paste content in as plain text. This sometimes requires removing the
current content and repasting it.

Solution:

To paste as plain text you can either right click and select that from the options or you can
click CTRL + SHIFT + V. You can also toggle this button and that’ll make all pasted content
remove formatting.

Removing external formatting will improve design consistency and in some cases accessibility
as well. In some less common cases, some specific formatting may lock a page after trying to
edit that template again.

Note: pasting as plain text will remove links so you will have to relink items.

How to link properly



The website is setup in three separate locations called stages. There is dev.bigbend.edu,
test.bigbend.edu, and www.bigbend.edu. They are setup to enable a technology called
staging where changes are made in one stage and then moved to a different stage for
another action. Our staging is setup so that all changes are made in dev.bigbend.edu (you
can’t even login into the other stages), then pushed to test.bigbend.edu as an intermediary
step, and then pushed to www.bigbend.edu which is the public facing site. The staging
software is fairly intelligent and can update most of the links within the website so that they
still link to each other even though the domain is changing. Unfortunately not all links are
updated since there are additions to the site functionality that aren’t checked. Because of
this, you should know what domains to use where as well as other useful linking information.

How to properly link internally (i.e. use either www.bigbend.edu or dev.bighend.edu not
www.dev.bigbend.edu or just https://bigbend.edu). Some places need the www version
because they don’t change through the versions (documents, sliders, forms)). iFrames can be
dev.bigbend.edu.

Show how to link email addresses, phone numbers, and texting numbers.
When to use dev.bigbend.edu, test.bigbend.edu, and www.bigbend.edu.

e First and formost, do not link to just dev.bigbend.edu, you need to fully qualify the
link to https://dev.bigbend.edu. The same goes for www.bigbend.edu and
test.bigbend.edu, they’d become https://www.bigbend.edu and
https://test.bigbend.edu.

e If you are adding/editing a link within the page builder, use https://dev.bigbend.edu.

e If you are adding/editing a link within a document that’s being uploaded to the
website, use https://www.bigbend.edu even though you are uploading it to
dev.bigbend.edu.

e If you are adding/editing a link within a form (Caldera Forms or NinjaForms), use
https://www.bigbend.edu even though you are editing it on dev.bigbend.edu.

e If you are adding/editing a link within a slider (Masterslider), use
https://www.bigbend.edu even though you are editing it on dev.bigbend.edu.

There is a correct way to format internal links and an incorrect way. Several incorrect
examples are www.dev.bigbend.edu and https://bigbend.edu. The correct ways would be
https://dev.bigbend.edu and https://www.bigbend.edu.

You may have also noticed that some links are ones that don’t link to a website, page, or
document, but rather to an email address or phone number. Below explains what the ‘URLs’
should be for those types of links.
e When linking to an email address (to allow users to click on to open their email
application), it should automatically fill out the correct syntax. If it does not, it will be
mailto:youremail@bigbend.edu.




e When linking to a phone number (to allow mobile users to click on to open their
phone app to call) it will be tel:(509) 509-5095.

e When linking to a phone number (to allow mobile users to click on to open their
texting app) it will be sms:(509) 509-5095. Remember that the number will need to be
one that is capable of accepting texts.

How to access the website
What?

If you weren’t shown how to access the backend, follow the steps below.

How?
1. Ensure you are connected to the campus network by one of the following.
a. Be on campus while connected to the internet there.
b. Use VMware. Contact BBT to help you set that up.
c. Use the Cisco Anyconnect VPN. Contact BBT to help you set that up.
2. Go to the Big Bend website at www.bighend.edu.
3. Click on My Apps at the top right links.

My Apps Student Kiosk Portal Password Help

lAmM v Academics v Student Center About Us + jo

4. Sign in using your BBCC credentials.
5. Click on the WordPress Console. If you do not see that option, contact Matt Killebrew
to setup access.

» ) @) Bis Bend

SECURF ! _
&) FILE SENDER \‘:‘J WORDPRESS

Note: access to the website requires two-factor authentication. If you do not have that setup,
it will prompt you to set it up for the first time.



http://www.bigbend.edu/
https://bigbend.okta.com/

Standard steps to build a page

whatz
This will show the basic required steps to build a new page. It will link to various locations in
the document that give in depth explanations.

How?
1. Goto Pages->New Page.

@ Dashboard Pa ge S

- Goodlayers

All (5560) | Mine {217) | Published (528) | Drafts (32) | Trash (37}
\@ WP Activity Log | Bulk actions  w || Apply | All dates v | All Read:
A Posts () Title
o] i —
«] Media [ ] Home — Front Page
W Pages
All Pages (] 1Am
Add New
Add Page Link (] — Advanced Technologies Education Center

. Comments

[ | — Aircraft Rescue Fire Fighting Training

A Personnel

2. Set a page title. Ensure that it isn’t too long (up to three words is recommended) and
avoid adding BBCC, Big Bend, or Big Bend Community College in the title as that’s




redundant. Keep in mind that setting a title affects the default URL for that new page.

B, o=

New Program Titlé

Type / to choose a block

Page Builder

Wrapper / Columns & Elements ] Custom Templates () SsyncTemplates

N A O iy M A

Wrapper 17 12 /4 34 15

3. Set the parent page. It will list all of the published pages, but we will only choose
from | Am, Academics, Student Center, and About Us (these correspond to the menu).
Choosing which one depends on where the page will live. If it’s a new program page,
it will be Academics as that’s where all the program pages reside. If it’s related to
Financial Aid, it’d be under Student Center. Please note that the Parent Page box
search does not work properly, you will need to scroll through and select the page
there (the top level pages are not indented). The parent page also determines the URL




for the new page.

Page Block x

SEQ analysis:
Improve your post with Yoast SEQ

Permalink -~

URL Slug

‘ new-program-title

The last part of the URL Read about
permalinks (7

View Page

https://dev.bigbend.edu/new-program-

Featured image ~
Discussion ~
Page Attributes ~

Parent Page:

=

Crder ‘ 0 ‘

MNotification Bar 4

Select Motification Bar (optional):
Enter Notification Bar Title
4. (optional) Set the URL. When you set the Title and Parent Page, it sets a default URL.
You can modify the URL value set by the Title by editing the URL slug. In most cases
you do not want your page title to be different from your URL, but in some cases the
title is long causing the URL to also be very long. In those cases you can set the slug to




be the program acronym or something similar.
Save draft Preview m n [7_]'

Page Block x

‘ Eliiah Bozin v ‘

.
Page Links To ~

Point this content to:

o Its normal WaordPrass URL
O A custom URL

Yoast SEO ~

SEC analysis:

Improve your post with Yoast SEO

Permalink ~

URL Slug

N

The last part of the URL. Read about
permalinks (7

View Page

https://dev.bigbend.edu/npts [

Featured imane ~

Set the title background image. Follow these instructions and guidelines.
Set the template. Choose a starting template (usually Department Page, Program
Page, or Basic Page). To do so, navigate to Custom Templates (number 3) and search
it there.
Edit the content as needed. Ensure that you write quality content as the website is
the forefront to the college in many respects.
a. Ensure you follow accessibility guidelines.
b. Ensure you keep consistent design by following the instructions with each
template in the Custom Template Guide.
c. Ensure the text you write is readable. One of the pits we often fall into in
higher education is the use of wordy and unnecessarily complicated words. A
good tool to check how readable your content is the Hemingway Editor. A
good score to go for is Grade 10 or less.



https://hemingwayapp.com/

8.

d. Ensure that your content and images are equitable.
Save Draft. Frequently click the Save Draft button to save progress. The Save Options
button within templates does not save overall progress, just changes within the page
builder.

Submit for Review. When ready, click the Publish button and then will slide in the
Submit for Review button. Click that and your page will be sent off to be reviewed
before it’s published. Be sure to only click this once as every time it is clicked it will
send an email to all of the set personnel (to save editing progress, use the Save Draft
button).

Howdy, Elijah Bozin

Page Block *
| Eliiah Bozin - |
P

Page Links To

Point this content to
o [t= normal WordPress URL
".f_\) A custom URL

Note: Pages submitted won’t be published right away, though they usually are fairly quickly.
Plan accordingly. Additionally, published page won’t be public until the website is pushed live
which happens automatically based on the schedule below and manually by site admins. In
the case of an emergency (avoid situations like these), inform Matthew Killebrew.

SUN MON TUE WED THUR FRI SAT

DEV -> DEV -> DEV -> DEV -> DEV ->

TEST TEST TEST TEST TEST 10:05 PM
TEST -> TEST ->
PROD PROD 10:05 PM




Archived Templates

This contains older instructions for templates that have been replaced in the Custom Templates section,
but may still exist in the website as updated templates aren’t propagated automatically.

Contact Block (archived)
What and Why?

Program/Department Contact

& Primary@emai H Building 1800

« (509) 508-5095 F Room 1800

Description: The Contact Block provides contact information at the bottom of a page (as a
page footer).

Resizable: No.

Compatible Pages: Department Page, Program Page, Basic Page

Additional Notes: This is not a full screen width template. This is meant to be the only page
footer template. If you’d like add/remove a section, consider using the Contact/Staff Block,

Contact/Staff/Links Block, Contact/Links Block, or Links Block.

How?

1. Search within the Custom Templates “Contact Block” (case insensitive and partial
keywords allowed)

rapper olumns 5 iemeni (DM mj| Sync Templates
E Wrapper / Col & Elements ) Custom Te ) Sync Templat

iFrame Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block




2. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Example Title Text

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem
sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur
maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla,
consequat ut ante sed, sagittis venenatis sem. Aenean non negue sapien. Fusce
dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non
erat. Praesent eu tristique arcu, vel facilisis mi.

3. To edit the Title, see the Title Element (start on step 3).
4. To edit the contact information, click the pencil icon to edit the template (orange
outline with the Text Box title)

Program/Department C




5. To edit the email address, replace the highlighted text with an email address.

File v Edit v View » Insertv Format e Tools v Table »

v GDLR Core v | AAv

v

o
~
i

T EH o @B RN

Y
([}

[su_icon icon="icon: envelope-o" background="transparent” color="white" size="16" margin="0px 0px Opx

opx” target="self"][/su_icon] Primary@email.com

[su_icon icon="icon: phone" background="transparent” color="white" size="16" margin="0px 0px 0px 0px"

target="self"][/su_icon] (509) 509-5005

Then once you type in an a new email, add a hyperlink and paste mailto: in front of
the email address as the link.

| L= UL w VICYY W naciL v I wnnan v Juis w g v

U = E v :: i :: '.3 GDLR Core v | AR

B o BBl R [

w
~

14
U]l
il
i

[su_icon icon="icon: envelope-o" Dackground="transparent” color="whit

opx" target="self"][/su_icon] Primary(@email.com

[su_icon icon Primary@email.co Iﬂ'ﬂ lite" si:

target="self"][/su_1icon| (500) 500-5005

maailto:

6. To edit the phone number, replace the highlighted text with a phone number (in this

format).
File v Editv View v Insert v Formats Tools v Table »

B I Ty T v = £ = GDLR Core v | AAv

[su_icon icon="icon: envelope-o" background="transparent” color="white" size="16" margin="0px Opx 0px

opx” target="self"][/su_icon] Primarv(@email.com

[su_icon icon="icon: phone" background="transparent” color="white" size="16" margin="0px 0px 0px 0px"

target="self"][/su_icon] (509) 509-5095

Then once you type in a new number, add a hyperlink and paste tel: in front of the



https://developers.google.com/style/phone-numbers#:~:text=To%20format%20phone%20numbers%20in,with%20the%20four%2Ddigit%20number.
https://developers.google.com/style/phone-numbers#:~:text=To%20format%20phone%20numbers%20in,with%20the%20four%2Ddigit%20number.

number as the link.

e w diL w WILwE W NiJwIL w o w Juiy w LA W

w
~

] = v E v :: i :: "3 GDLR Core «

s @0 E-EIRN

[su_icon icon="icon: em'elope—&ckground="transparent" color=""
opx" target="self"][/su_icon] Primarv@email.com

[su_icon icon="icon: phone" background="transparent" color="whits
target="sel{"][/su_icon] (509) 509-5005

| 92090093 I 'ﬁ'

The instructions to edit the other contact information is similar, except linking it
optional. If you don’t need particular information, you can delete an entire section (as
shown in highlighted text).

0 Add Media ] [e, Caldera Form l el icade Visual | Text

File v Edite View» Insertw Formate Tools v Table »
B
EFTHoE-BES RN

GDLR Core v  AAY

~
[
i
4
T
4
"
il
Iil

14

[su_icon icon="icon: building-o" background="transparent” color="white" size="16" margin="0px 0px Opx 0px"
target="self"][/su_icon] Building 1800

[su_icon icon="icon: map-signs" background="transparent” color="white" size="16" margin="0px opx opx opx"
target="self"][/su_icon] Room 1800




8. Click Save Options and then click Save Draft.

B save Options

————

Save draft Preview m

9. If you are finished making changes, you can click Publish and then Submit For Review.

Links Block (archived)
What and Why?

Additional Links

% Link

@ Link

Description: The Links Block lets you list additional links to other pages, media, or websites.
Resizable: No.

Compatible Pages: Department Page, Program Page, Basic Page

Additional Notes: This is not a full screen width template. This is meant to be the only page
footer template. If you’d like add/remove a section, consider using the Contact/Staff Block,

Contact/Staff/Links Block, Contact/Links Block, or Contact Block.

How?




6. Search within the Custom Templates “Links Block” (case insensitive and partial
keywords allowed)

Wrapper / Columns & Elements Sync Templates
PP y P!

iFrame Element Map Element Alert Box Element Back To Page Element Contact Element Tabs Element

White Divider Element Diader Element Text Box Element Title Element Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page

Content/Hours Block Links Block

Bxample Title Text _icon i con: arrow-left"
background="transparent”

color="white" size="16" margi
Ex@mple Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac lorem

Opx Opx Opx" target="self"] [/su_icon]
Back to mainpage

sef] augue imperdiet posuere nen non elit. Donec tempus sapien in erat efficitur
mdiximus. Curabitur ultricies a nibh convallis sodales.

Cyyabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nulla,
cdhsequat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce

pibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non
at. Praesent eu tristique arcu, vel facilisis mi.




To edit the links, click the pencil icon to edit the template (orange outline with the
Text Box title)

Tn = & X

: link” background
)px Opx Opx Opx" targ

[su_icon icon="icon: file-pdf-0" backg

color="white" size="16" margin="0px Op

You can then change the text that shows, edit the hyperlink (by selecting the text and
clicking the link button)

File v Editw View v Insert» Formate Tools v Table v

Ty v = = = GDLR Core v AAY

o BrpE 2 R

w
~

*
(U]}
{11]}
*
B

[su_icon icon="icon: link" back®ound="transparent” color="white" size="16" margin="0px Opx 0px Opx"

target="self"][/su_icon] Link
D — Y

[su_icon icon="icon: file-pdf-o0" background="transparent” color="white" size="16" margin="0px 0px 0px opx"
target="self"][/su_icon] Link

[su_icon icon="icon: link" background="transparent” color="white'
target="self"][/su_icon] Link

[ Intips://bigbend.ed

targei= 75u_lcon] Link

ﬂ' arent” color="
a—

You can also click the gear to let you enable the link to open in a new tab.




10. You can also change the icon by changing the highlighted text.

File v Edit« Viewy Inset~ Formate Tools v Table »

o GDLR Core v | MAv

@
("

i
Iul
Eb 1
<
I
b :
g
D
55
p|

[su_icon icon="icon: link" background="transparent” color="white" size="16" margin="0px 0px 0px opx"
target="self"][/su_icon] Link

[su_icon icon="icon: file-pdf-o” background="transparent” color="white" size="16" margin="0px Opx Opx 0px"

target="self"][/su_icon] Link

The common options are shown below. Copy the non-bold text into the text editor.
Standard link: [su_icon icon="icon: link" background="transparent" color="white" size="16"
margin="0px Opx Opx Opx" target="self"][/su_icon] Link
PDF link: [su_icon icon="icon: file-pdf-0" background="transparent" color="white" size="16"
margin="0px Opx Opx Opx" target="self"][/su_icon] Link
Word link (not recommended due to PDFs being better supported on mobile): [su_icon
icon="icon: file-word-o" background="transparent" color="white" size="16" margin="0px Opx
Opx Opx" target="self"][/su_icon] Link

11. Click Save Options and then click Save Draft.

B save Options

L1
[=%]
=

12. If you are finished making changes, you can click Publish and then Submit For Review.

Contact Element (archived)

What and Why?



Contact Text

B Primary@email.com

t. (500) 509-5095

B Building 1800

¥ Room1800

Description: The Contact Element provides contact information for pages that don’t use the
Contact Block or similar page footer blocks. Generally, these are used for pages that aren’t
exactly standalone departments/programs but are more of separate services that have
different contact information than standard pages.

Resizable: No.

Compatible Pages/Blocks: This can be swapped with the right section of either Basic Page or
Default Block (for this block, you will need to resize the Default Block to 2/3 to fit, see How to
properly resize templates).

Additional Notes: this is not a full width template. This should not be used in combination
with the Back To Page Element or the Hours Element. If either of those are already being
used a page, consider using one of the following footer blocks for providing contact
information: Contact Block, Contact/Links Block, Contact/Staff Block, or Contact/Staff/Links
Block.

How?

To edit the contact information:
1. Hover over the text and click the edit button (pencil icon).

amet, consectetur adipiscing elit. Praesent ac

TextBox [ & X
-

non non elit. Donec tempus sapien in erat efficitur
onvallis sodales. color="white" size="16" margin="
Opx Opx Opx”][/su_icon]

lio quis, porta lobortis mi. Aenean purus nullg, Primary@email.com

natis sem. Aenean non neque sapien. Fusce

2. Edit the contact information with the correct information. The first section is for your
email, the second is for your phone number, the third is for building number, and the




fourth is for the room number. Edit only the highlighted sections.

UL

) Add Media | | @ Caldera Form | [1 Insert shoricods

File w Edit« WView » Inserf v Format« Tools v Table »

B J U =+ =+ = = = GDLR Core v  AAw
EFT R oE B2 R[N

[su_icon icon="icon: envelope-o" background="transparent” color="white" size="16" margin

opx"][/su_icon] Primaryvi@email.com

[su_icon icon="icon: phone" background="transparent” color="white" size="16" margin="o0;

[/su_icon] (509) 509-5095 :

[su_icon icon="icon: building-o" background="transparent” color="white" size="16" margin:
opx"][/su_icon] Building 1800

[su_icon icon="icon: map-signs" background="transparent” color="white" size="16" margin:
opx"][/su_icon] Room 1800

Text Align

3. When adding the hyperlink for the email or for the phone number, just add mailto: in
from of your email address and tel: in front of the phone number.

[su_icon icon="icon: envelope-o" background="trans
opx"][/su_icon] Primary_@e!maj].mm

. { mailto:Pri - 2.
[su_icon i mailto.Primary@email.com g 2 ranspare
el

[T TR et B e Ta T s Ve B ¥ o Wi

[su_icon icon="icon: phone" background

[/su_icon] (509 ;_539:5@5

[su_icq EEL2095095095 ﬁ &2 backgrc
opx"1[/su_icon] Building 1800




4. If you don’t need a section (eg. the room information), simply select the entire

shortcode and delete it.
[su_icon icon="icon: building-o0" background="transparent” color="white" size="16" margin="0px O0px Opx

opx"][/su_icon] Building 1800

Text Align

5. Click Save Options and then click Save Draft.

6. Be sure to edit the Title Element in this template. To do so, hover over the Title
Element and click the edit button (pencil icon).

Tile 2 W X
lesent ac [su_icon icon="icon: envelope-o"
n erat efficitur background="transparent”

color="white" size="16" margin="0px

Opx Opx Opx"][/su_icon]

Irus nullq,

Primarv@email.com




7. Change the text under ‘Title’. Something like ‘Art Contact’ or some other value
replacing ‘Art” would work well.

Title

Contact Text

Caption

8. Click Save Options and then click Save Draft.

9. If you are finished making changes, you can click Publish and then Submit For Review.

How to replace a right-side template with the Contact Element:

1. Delete the pre-existing right side template (be sure to delete the yellow highlight,

which indicates the column).

tis W& x

[su_icon icon="icon: arrow-left"
background="transparent”

color="white" size="16" margin="0px
1 dolor sit amet, consectetur adipiscing elit. Praesent ac

Opx Opx Opx" target="self"|[/su_icon]

»t posuere non non elit. Donec tempus sapien in erat efficitur Back to moin;:ggg

2s a nibh convallis sodales.

imus ut odio quis, porta lobortis mi. Aenean purus nulla,
gittis venenatis sem. Aenean non neque sapien. Fusce

L




2. Once removed, search within the Custom Templates “Contact Element” (case
insensitive and partial keywords allowed)

Wrapper / Columns Elements Sync Templates

iFrame Element Map Element Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Divider Element Space Element Text Box Element Title Element Default Block

Video Lightbax Block B s Featured Element Featured Block Personnel Card Page Personnel Bio Page

Element

Content/Hours Block i Links Block

Contact Element

Example Title Text Contact Text

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac

lorem sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur

maximus. Curabitur ultricies a nibh convallis sodales. color="white" sizi " margin="0px
0Opx Opx 0px’][/su_icon]

Curabitur lectus nibh maximus ut odio anis norta lobortis mi Aenean nuris nuolla

4. Proceed to follow the previous instructions on how to edit the contact information
(To edit the contact information).

Basic Page (archived)

What and Why?

Example Title Text € Bock to mainpage

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac
lorem sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur
maximus. Curabitur ultricies a nibh convallis sodales.

Curabitur lectus nibh, maximus ut odio quis, porta lobortis mi. Aenean purus nullg,
consequat ut ante sed, sagittis venenatis sem. Aenean non neque sapien. Fusce
dapibus, urna ac dictum efficitur, dui turpis molestie libero, at ultrices erat purus non
erat. Praesent eu tristique arcu, vel facilisis mi.




Description: The Basic Page is designed to house content that needs to be separated (either
for space, information specificity, etc.) from a landing/primary page. It can be considered a
sub-page template of sorts, but it can be used as a primary page if the Back To Page template
is replaced with a different one (see swappable elements).
Examples of usage are the Testing Center and the Art Student Gallery pages
Resizable: No.
Swappable Elements:
e Right section: The right section can be swapped with the following compatible
elements; Back To Page Element, Hours Element, or Contact Element.
e Other: You can add the Contact/Staff/Links Block, Contact/Staff Block, Contact Links
Block, Contact Block, or the Links Block to the bottom.

Additional Notes: this is not a full width template.

How?

1. Search within the Custom Templates “Basic Page” (case insensitive and partial
keywords allowed)

Wrapper / Columns X ] Custom Templates () SyncTemplates

iFrame Element Map Eement Alert Box Hement Back To Page Element Contact Element Tabs Element

White Divider Element Diider Element Space Element Text Box Element Title Hement Default Block

Featured Image

Video Lightbox Block Element

Featured Element Featured Block Personnel Card Page Personnel Bio Page
Content/Hours Block Links Block:

Program Page Department Page

2. Drag the template from the Custom Templates list and then drop it into an empty
page.

rance Example Title Text [su_icon icon="icon: arrow-left"
s 1 background="transparent”

color="white" size="16" margin="

Example Text. Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent ac

Opx Opx Opx” target="self'][ /su_i
lorem sed augue imperdiet posuere non non elit. Donec tempus sapien in erat efficitur Back to mainpage

maximus. Curabitur ultricies a nibh convallis sodales.



https://www.bigbend.edu/student-center/testing-center/
https://www.bigbend.edu/academics/art-student-gallery/

3. Click Save Options and then click Save Draft.

To edit the Title, see Title Element (start on step 3).

To edit the primary content, see Text Box Element (start on step 3). Other templates can be
added into the primary content section (gray background).

To edit the link to the primary page (blue background), see Back To Page Element.

If you are finished making changes, you can click Publish and then Submit For Review.

Back To Page Element (archived)

What and Why?

+ Back to mainpage

Description: The Back To Page element let’s you place a link pointing back to a previous page,
presuming the current page is related some other ‘main’ page. It’s common for this to be
used on FAQ pages or other pages providing additional pages related to a program or
department.

Resizable: No.

Compatible Pages/Blocks: This can be swapped with the right section of either Basic Page,
Default Block (for this block, you will need to resize the Default Block to 2/3 to fit, see How to
properly resize templates).

Additional Notes: this is not a full width template. This should not be used in combination
with the Contact Element or the Hours Element. If either of those are already being used a
page, consider using one of the following footer blocks for providing contact information:
Contact Block, Contact/Links Block, Contact/Staff Block, or Contact/Staff/Links Block.

To edit the link this goes to:




1. Hover over the text and click the edit button (pencil icon).

TexiBox XWX K arrow-left
] -
parent

color="white" size="16" margin="0px

Opx Opx Opx" target="self"][/su_icon]
Back to mainpage

citur

2. Click on the ‘Back to mainpage’ text and then click on the pencil button.

B I U = v =S v = = = GDL
= T E o E B2 N

[su_icon icon="icon: arrow-left" background="transparent

target="self"][/su_icon] Back to mainﬁﬁe

# 2 R
[ ]

3. Replace the # with the new URL and click the apply button.
Wt e NEW - T SR LT AP

[su_icon icon="icon: arrow-left" background="transparent” color="whii
target="self"][/su_icon] Back to mainpage

P B <




4. Click Save Options and then click Save Draft.

B save Options

R

Save draft Preview m

5. If you are finished making changes, you can click Publish and then Submit For Review.
To add an template that uses the Back To Page template, go here.

Video Lightbox Block (archived)
What and Why?

C,

See What It's All About

Description: The Video Lightbox let’s you display a video in a lightbox form. This is more
attractive than the regular Video Element template, but takes more room.

Resizable: No.

Compatible Pages: Department Page, Program Page

Additional Notes: This is a full screen width template.

To add the video lightbox and edit the video it opens:




6. Search within the Custom Templates “Video Lightbox Block” (case insensitive and

partial keywords allowed)

Wrapper / Columns & Elements

iFrame Element Map Element

White Divider Element Diader Element

Featured Image

Video Lightbox Block Element

Buttors Block Hours Element

] Custom Templates

Alert Box Hement

Space Element

Featured Element

Content/Hours Block

() SsyncTemplates

Back To Page Element Contact Element

Text Box Element Title Element

Featured Block Personnel Card Page

Links Block

Tabs Element

Default Block

Personnel Bio Page




7. Drag the template from the Custom Templates list and then drop it into a compatible
template.

Example Title Text

Description of what this program is and the expected outcor
augue imperdiet posuere non non elit. Donec tempus sapier

Curabitur lectus nibh, maximus ut odio guis, porta lobortis m
neque sapien. Fusce dapibus, urna ac dictum efficitur, dui tu
facilisis mi.

8. To edit the video that shows up when a user clicks on the play image, click this pencil
icon (orange outline with the Image title)




t1n Z & & x X

Image @& & 1EXx
=]

Then scroll down to ‘Video URL’ and paste your link there (must be a YouTube or
Vimeo link).

Link To

Video Lightbox w

Video Url { Youtube / Vimeo )

hitps-/fyoutu. befilITODhzHas
L e

Overlay Icon

Mo Overlay w

9. Click Save Options and then click Save Draft.

R

Save draft Preview m

10. If you are finished making changes, you can click Publish and then Submit For Review.




To edit the large text:
7. Click this pencil icon (orange outline with the Text Box title)

8. Update this text here. Be sure to keep it concise and short (for mobile friendliness).

Content

l Q7 Add Media ] l" Caldera Form ] L1 Insert shortcode

File v Edite WVieww Insert» Formate Tools » Table »
GDLR Core v AAv

-

v

@
~

u

s B OoOHE B RN

e
L]}
Il

See what it's all about
€

P

9. Click Save Options and then click Save Draft.

————

Save draft Preview m

To change the lightbox background image:




5. Click this pencil icon (yellow outline with the 1/1 title)

tan Z B & x X
-




6. Go to the Background tab and scroll down to the ‘Background Image’ section. Click
the x to remove the current background.

Genera Background Border Spacing Custom Skin

——

Full Height Wrapper

m
i)
5]
I
4
]
o
m
n
1
i
]

Sync Height
Use 10 sync the heignt amon
be fixed so be cautious not £
Positioning Content In The Middle Of This Item { When sync hieght / Full height is being uses

OFF

Background Type

Image v

Background Color Type

Plain Color v

Background Extending

Mone v

Background Color

Can also be use as a base oo
- Select Color
Background Imaae

o




7. Click the plus to add a new image from the Media Library. (If adding a new image,
follow the Media upload and accessibility instructions)

Background Image

+ —
Background Image Style

Do not change the other settings.
8. Click Save Options and then click Save Draft.




